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Welcome to Axiom Contract
Management

Kaufman Hall’s contract modeling and analytics tool helps organizations better predict and manage
payments, and leverage a data-driven approach for improved payer negotiations. With this software,
you can estimate net revenue by patient, and better manage contracts, claims, and payments across
your organization from both managed care and government payers.

Kaufman Hall’s Axiom Contract Management solution helps healthcare organizations:

l Inform payer contract negotiations using empirical and modeled data

l Understand the financial impact of proposed changes to contract terms

l Optimize estimation of net patient revenue across inpatient and outpatient populations

What is covered in this document
This guide is for Axiom Contract Management administrators. System administration involves basic
configuration and maintenance tasks, some that you perform only once, and some that you need to
perform regularly. You perform most admin tasks from the Axiom Contract Management Web Client.
Any tasks that are performed from the Desktop Client are noted as such.

System administrators model contracts that other users view and use in processing claims and creating
and viewing reports.

1
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This guide includes the following administrations features and tasks:

l Importing data – Building claim formats and other import formats, importing files to the system,
and viewing import activity

l Managing attributes – Creating, editing, enabling /disabling, and deleting attributes
l Modeling contracts, including building contracts (adding versions, provisions, attributes, clauses

and terms, thresholds and limits; attaching files and importing rates; copying contracts; and
more)

l Managing simulations – Creating, editing, and copying simulations; mapping simulations to drill-
down reporting

l Security – Application security roles and their associated access rights

What's new
Welcome to Version 2019.3 of Axiom Contract Management!

Enhancements in this release include:

l Map Provider names to Org codes tool – NowContract Management administrators have a new
tool that allows them to map Provider names to Org Codes and add newOrg Codes to the
system. Previously, this task required assistance from Axiom Software Client Success.

l Drill-down reporting for APCs is extended to other simulations – Axiom Contract Management
now supports drill-down reporting on line-level calculation detail results for grouped and priced
APCs for any simulation configured for drill-down reporting. Use the new drill-down reporting
fields to compare line-level APC calculation detail results.

l Shift claim dates for Group and Price – Users who group and price claims for APC and eAPG
contracts can now shift dates on claims forward or backward in time to accurately understand the
impact of CMS grouping and pricing logic.

l New payer code options for claims processing – Nowusers who group and price claims and who
recalculate claims can do so by Insurance Plan Code.

l Payer option rename – The Payer option on the Group and Price Claims page and the Recalculate
Claims page has been renamed to “Contract” to better reflect what this option does, and to
distinguish it from the new Insurance Plan Code option.

l Postings breakout for enhanced variance reporting – New reporting fields on drill-down reports
for the Claims tab allow you to break out payment and adjustment posting totals by type for
improved contractual variance reporting.
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l Enhancements to file importing
o New SQL Importer Log – A new SQL importer log available to administrators provides

better visibility into the nightly import process. The SQL importer log records details about
the last import that took place, including any errors, in an easy-to-view format.

o Option to import Posting files using Axiom ETL – As part of an ongoing update to the
import process, posting files can now be imported using Axiom ETL as part of the existing
Axiom Contract Management Full Import job. Users need to provide a posting file with
category breakouts for payments and adjustments. These files are imported to the system
and processed. The supplied category breakouts can be used in drill-down reports.

o File handling verification for duplicate flat delimited posting files – In the Notes section
of theManage Import Batches page, duplicate files that are not imported are noted as
such, and the import report is updated to show that the file was skipped as a duplicate.

o EDI file inspection and removal of problem files –When problem files are encountered
during the import process, the system nowmoves these files to specific folders where users
can find them, and then updates the import reports in various places. Problem files include
duplicates, files with invalid formats, and unreadable files.

l 3M June 2019 quarterly update – Each quarter, 3M provides an update to the 3M GPS Grouper
software integrated into Axiom Contract Management. This update includes grouping, pricing,
and regulatory updates to the APC and State-specific eAPG groupers.

Map provider names to Org codes
Contract Management administrators can nowmanage provider namemappings to organizational
codes in their systems using the new Provider Org CodeMapping tool.

When a claim enters the system, the provider name on it is checked against the existing list of names. If
the name is different in any way from the names already in the list (for example, spelling or word order),
it is added to the list. Administrators can then map the new provider names or the name variances to the
correct Org codes.

By default, new provider names come in with the default code. You can select the desired name from the
Org Code drop-down or, if needed, you can create a newOrg code.
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To map a provider name to an Org code:
1. In themain menu header, from the Admin menu, select Provider Org Code Mapping.

2. Locate the provider name in the list on the left. Names are listed in alphabetical order.

3. In theOrg Code column, from the Org code drop-down for the corresponding provider name,
select the desired Org code. The change is saved automatically. If the needed Org code does not
exist, you can add it using the following instructions.

4. To propagate the provider name and Org code association to existing claims, recalculate the
claims.

To add a new Org code:
1. In themain menu header, from the Admin menu, select Provider Org Code Mapping.

2. In the Add New Org Code section, in theOrg Code field, type the number to associate with the
Org code.

3. In theDescription field, type the Org code description.

4. Click Save.
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Compare G & P line-level APC calculation detail results
Users running drill-down reports on claims and line items can now include line-level calculation detail
results created from grouping and pricing APCs from any simulation configured for drill-down reporting.
You can now do a side-by-side simulation comparison down to the line-level of detail to compare the
impact of APC schedule changes on a set of claims.

NOTE: Your Axiom Contract Management administrator sets up simulations for drill-down reporting.

Claims and Line-level APC results for up to four simulations at a time
In addition to the Live simulation, up to four simulations can be set up to handle reporting of APC detail
at the claim level. Previous to the 2019.3 release, we only stored grouped and priced APC results from the
Live simulation. In this release, we have extended grouping and pricing to all other simulations. The fields
that are populated on the Claims and Line items tabs are available for the other four simulations selected
for drill-down reporting. This means there are now four new fields for each claim and line level field
currently populated during the group and price process (for example, fields such as PPSPayment, CoPay,
Outlier, etc.).

New Line Item Groupings
added include the APC#
and StatusIndicator# 2 - 5
as shown in the following
example.

New Line Items Measures
added include the following:

New CMS Measures added
for Claims include the
following:
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To use these new fields in a drill-down report:
1. Run an APC group and price against claims in a simulation mapped to drill-down reporting:

a. Ensure your simulation environment contains the APC contract(s) with the appropriate
Schedule(s).

b. Ensure your simulation environment is mapped to drill-down reporting. You may need to
verify this with the Axiom Contract Management administrator.

c. Group and price the desired set of APC claims for the desired simulation (or simulations, if
you are performing a comparison). For more information, see Group and price APC and
eAPG claims.

2. Create a drill-down report using the desired Claim tab or Line Item tab fields, then add filters to the
report as needed to limit the data included, and then generate the report.
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For more information, see the following:

l Build a new drill-down report
l Apply filters to a drill-down report
l Export a drill-down report

New payer code option for grouping and pricing and recalculating claims
Users who group and price and recalculate claims now have the additional option of grouping and pricing
and recalculating by Insurance Plan Code. If a new insurance plan code is added to a version and you
need to group and price related claims or recalculate those claims, you do not have to process all the
claims for that version; instead, you can select to process only the claims that have that specific
insurance plan code.

Recalculating selected insurance plan code

For more information, see the following:

l Group and price APC and eAPG claims
l Recalculate a claim

Shift claim dates for grouping and pricing forecasts
Users who group and price claims for APG and eAPG contracts can shift dates on claims forward in time
to accurately understand the impact of new CMS grouping and pricing logic for the upcoming year.
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IMPORTANT: The shift claim dates feature works only in non-Live simulations.

When the new CMS grouping methods and schedules are released, you can get a forecast of how they
will affect your APC and eAPG claims reimbursements by running some of your historical claims through
the grouping and pricing process using the new rules. Normally, grouping logic prevents you from using
future logic against historical claims because they are service-date specific. However, if you shift your
historical claim dates into the next year, you can align your service dates with the 3M logic.

NOTE: You can also shift the dates backward in time by using a negative number of units. You might
do this if you want to knowwhat this year’s claims reimbursements would have paid last year.

The Group and Price Claims page includes a Shift Date By section that remains inactive until you select a
non-Live simulation in which to group and price your claims. You can use the date shift feature for any
claims selection method (Patient Account Number, Claim Number/UCRN, Date Range, etc.) as long as
you select a non-live simulation.

To date shift a set of claims for grouping and pricing:
1. In themain menu header, click Claims >Group and Price.

2. On theGroup and Price Claims page, from theGrouping/Pricing Type drop-down, select the
type.

3. In the Select claims by section, select an option, For details, see

4. From the Simulation drop-down, select the desired simulation.

IMPORTANT: The simulation must not be Live.

5. In the first Shift Date By field, click the up or down arrows to select the number of units to shift
the date by.
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6. In the second Shift Date By field, click the drop-down and select the unit to shift the date by
(Days, Months, Years).

7. Click Group and Price.

8. After grouping and pricing, view the claim voucher report to see the results.

In the following example, the top of the voucher report shows that the service took place in 2013,
but on the bottom, you see that for calculating the expected payment, it used a future Grouper
Schedule, and therefore, a different Grouper Logic.

Improve variance reporting with Posting subcategories
Users running drill-down reports on payment and adjustment posting totals can now break out these
items into subcategories for more detailed reporting. In addition to Total Payment and Total Contractual
fields, there are now 10 new payment and 10 new adjustment fields available in theMeasures column for
the Claims tab. These new fields allow you to break out payment and adjustment posting totals by type
for improved contractual variance reporting. You can use these fields to report on refunds, bad debt
adjustments, etc. The new drill-down report fields for adjustments are A1-A10. The new fields for
payments are P1-P10.

NOTE: To take advantage of this postings breakout feature, you need to provide a posting file with
category breakouts for payments and adjustments imported using Axiom ETL. This import can be in
addition to or part of the Axiom Contract Management Full Import job.

In the example below, adjustment fields A1 and A2 are used to break out primary contractual and facility
adjustments:
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Duplicate file check on flat delimited posting files
Now you havemore transparency into the Axiom Contract Management Full import job process for flat
delimited posting files. When the system encounters a duplicate file, it does the following:

l Date-time stamps the file and copies it to a duplicate file folder under the Imported folder location
from where the file is read. If the folder does not exist, the system creates it.

l Logs the attempt as a duplicate and updates the import report to show that the file was skipped
as a duplicate.

l In the Import Data >Manage Import Batches table, the Notes section records that the file is a
Duplicate and not imported, as shown in the following example:

For more information, see View import activity.

Improved import handling of problem files
Users running Axiom Contract Management imports now have greater visibility into what happens to
problem files when claims and remits are read into the system during the Axiom Contract Management
Full Import job. Problem files include duplicate files, files with invalid formats, and files that cannot be
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read because of structural or other issues. The new processing enables users to easily locate problem
files and take corrective action.

Previously, most of the information about the reading of EDI claims was reported to the Axiom logs, and
problem files were not easy to find. Nowwhen such problem files occur in imports, the system handles
them as follows:

� Duplicate files
The system:

l Date-time stamps and copies the file to a Duplicate file folder under the imported folder location
from which the file is read. If the Duplicate folder does not exist, the system creates it.

l Logs the attempt as a duplicate
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Duplicate
l Updates the import report to show that the file is a duplicate and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Duplicate - Not Imported

� Invalid format files
The system:

l Date-time stamps and copies the file to an Invalid Format file folder under the Imported folder
location from which the file is read. If the folder does not exist, the system creates it.

l Logs the attempt as an invalid format file
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Invalid Format
l Updates the import report to show that the file is an Invalid Format and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Invalid Type - Not Imported

� Unreadable files
The system:

l Date-time stamps and copies the file to an Unreadable folder under the Imported folder location
from which the file is read. If the Unreadable folder does not exist, the system creates it.

l Logs the attempt as an unreadable file
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Unreadable
l Updates the import report to show that the file is Unreadable and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Unreadable - Not Imported
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View importer logging
A new SQL importer log available to administrators provides better visibility into the nightly import
process. The SQL importer log records details about the last import that took place, including any errors,
in an easy-to-view format. Administrators can use this log as a diagnostic tool when errors occur because
it is more descriptive than the Axiom log.

The log records the following:

l SQL Import run ID number
l Task group ID
l Message – A brief description of the activity during each phase of the process
l Log Date/Time
l Exception – Error and associated information
l Error – Error flag True or False; True indicates an error

To view the SQL Importer log:
In themain menu header, click Admin > SQL Importer log.

3M July 15 2019 APC and eAPG quarterly update release
Each quarter, 3M provides an update to the 3M GPS Grouper software integrated into Axiom Contract
Management. This update includes grouping, pricing, and regulatory updates to the APC and State-
specific eAPG groupers.
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Understanding the Axiom Contract Management system
Axiom Contract Management is a web application backed by an SQL database that stores contract terms,
patient claims, and payment information. The system uses the contract payment terms and the patient
claim information to calculate an expected payment for every claim submitted by the provider.

Understanding the flow of data

From billing to Axiom Contract Management
Axiom Contract Management requires many pieces of data to function properly. It is important to
understand the entire process of how data comes into, and moves through, the system.

As shown in the following diagram, when billable procedures are performed at a hospital, services data is
entered directly into the hospital’s information systems (HIS). Patient Accounting generates claim data
from this information, and a bill in the form of an 837i/UB04 for institutional claims, and as an 837p/1500
for professional claims, is sent to the payer.

As these claims are sent out each day, a copy also goes to the Axiom Contract Management system.

NOTE: It is best to collect these claims after they have been sent through a claim scrubber so that
they reflect exactly what the payer receives.
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After claims are imported to Axiom Contract Management, they arematched to the associated payer
contracts that you modeled in the system. These contracts can be very sophisticated and may contain
combinations of services being paid at fee schedules, per Diem payments, lesser of terms, thresholds,
stop losses, and various other reimbursement methodologies. Ultimately, an expected payment is
generated for each claim that has a matching contract.

In addition, 835 remittance responses, along with posted payments and primary payer adjustments,
flow into Axiom Contract Management on a daily basis. With these five pieces of information (i.e.,
contract terms, claim data, payments, adjustments, and remittance responses), the expected
payment/contractual generated by Axiom Contract Management allows you to identify which claims
have or have not been paid correctly.

Understanding data requirements
This section provides file requirements for imported claim and financial data files.

Claim file requirements

� Institutional claims
l The UB must be in a true print image format. 837i/UB04 claim files need to be provided to

Kaufman Hall as EDI or text files. These files need to be provided on a daily basis to a folder on the
Axiom Contract Management server or on an existing server within the network. The UB must be
provided to Kaufman Hall in a true print image format—meaning that if the UB text file was
opened in a text editor and printed, it would line up perfectly on a blank UB92/UB04 form.

l When possible, a claim file should have an account number unique to the patient’s billing
episode. Some billing systems use what is known as a Claim # or a UCRN #, where this number is
specific to a particular bill and it changes every time the claim is submitted to a payer. Kaufman
Hall prefers to receive the Account # that is unique to the patient’s billing episode, and remains
unchanged regardless of the number of times it is generated from within the HIS. If it is not
possible to include the Account # on the claim, a daily additional data file is required from the
hospital. This file contains themapping of UCRN # to Account #.

l When possible, claims should be scrubbed before importing. It is Kaufman Hall’s preference to
receive the “scrubbed” version of the claim whenever possible because this allows for more
accurate expected payments.

l The insurance code/plan code/payer mnemonic should be placed in an unused box on the UB.
In most cases, the payer namewill not be sufficient. For example, patient accounts could put
“Blue Cross” on the bill, but it will not give Axiom Contract Management enough detail to
determine whether it is considered Blue Cross PPO, HMO, etc. Kaufman Hall would expect
something like BC.PPO or BC.HMO in this case. If this field is not on the claim by default, it could
be placed in an unused field (Box 30 on the UB04). If this is not possible, an additional data
download for this information will be required, or, as a default, the first payer name listed on the
claim will be used.
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l Each file must have a unique name. Kaufman Hall requires that each file have a unique name
concatenated with a date stamp (MMDDYYYYNAME.txt). For example, 01012018UB.txt would be a
UB file generated on Jan. 1, 2018, whereas 01012018COMM.txt would be a commercial payer file
for the same date.

� Professional claims
Professional print image claims, HCFA 1500s, have the same requirements as the institutional claims. The
file must be a print image unless the electronic 837p is provided. If the Account # cannot be provided on
the claim, then an additional mapping file is required. The payer mnemonic should also be contained on
the claim. Payer DRGs are not applicable to HCFA claims. For the HCFA 1500 files, Kaufman Hall also
requires that a unique provider identifier be put on every submitted claim.

Financial data file requirements

� Payments
Payment files must be flat ASCII text files. These files need to be provided daily. For all professional
payments, the required fields include:

l Account #
l Payment amount
l Payment date
l Posting date
l Payer name
l HCFA indicator (if applicable)

If an HCFA indicator cannot be provided in the file, separate downloads for both professional and
institutional payments are required. All report headers and footers should be stripped off the file. As with
the claim files, Axiom Contract Management requires that each file have a unique name. Typically we
expect the file to include a date stamp. For example, 01012018PAY.txt would be a payment file generated
on Jan. 1, 2018 (MMDDYYYYPAY.txt). Additional fields could include UCRN # and/or payment category or
group.

� Adjustments
The adjustment or contractual files should include only primary adjustments made to the account.
Secondary adjustments, balance transfer, etc., should be filtered out of the report. The required fields
include:

l Account #
l Adjustment amount
l Adjustment date
l Payer name

Administrator's Guide Axiom Contract Management │ 19



l HCFA indicator (if applicable)

As with payments, strip all report headers and footers from the report, and follow a unique naming
convention (e.g. 01012018ADJ.txt). Additional fields could include UCRN # and/or adjustment category or
group.

Additional data

Additional data downloads are required if, as mentioned earlier, certain elements of the claim files cannot
be provided on the print image of the UB or 1500. Those items can include account #, payer mnemonic or
DRG. Your Kaufman Hall representative will let you know if this is required based on the test claim files
submitted before installation.

Understanding data formats
All formats are built during system implementation; however, the system administrator is responsible for
ensuring that any format changes are reflected in Axiom Contract Management for importing to
continue smoothly.

IMPORTANT: If you do not maintain data formats in the system, you run the risk of inaccuracies in
your database.

� About formatting claim files for import
Both the UB and 1500 files are submitted to Axiom Contract Management in what is called print image
format. This means that the data element locations are consistent from one claim to the next,
throughout the file. When sent to a printer, a true print image file will print perfectly on an empty claim
form.

The Axiom Contract Management claim dataset is populated mainly by these print image files, which are
typically provided to the server on a scheduled basis for import and recalculation. To import into Axiom
Contract Management, a format must be set up for each unique print image to tell the system where to
look for each piece of information contained on the claim dataset. Sometimes providers need different
formats for different payers, even if they are all on the UB04, because the payer requires certain extra
fields, or the account # is longer for those payers, and to account for this, multiple formats can be set up
for the claim files types. Multiple formats can also be built for the financial and additional data
downloads. System administrators can build claims import formats if needed.

� About formatting financial data files for import
Financial information such as payments and adjustments are imported using a format as well; however,
these file types are inherently different from the print image claim files. Typically, they are provided to
the Axiom Contract Management server as flat ASCII text files. System administrators can build fixed-
width import formats.
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Managing data
This section provides information about importing data to Axiom Contract Management and integrating
data from the Contract Management system with other Axiom Software systems, as those integrations
become available in future releases.

Importing data to Contract Management
Axiom Contract Management receives the following information types:

l Contract terms
l Claim data
l Payments
l Adjustments
l Remittance responses

Claims and financial data (payments and adjustments, etc.) files must meet certain requirements before
importing to Axiom Contract Management. For importing, these files must also be in specific formats.
For more information, see Understanding data requirements and Understanding data formats.

In general, the import process involves the following main steps:

1. Building file import formats
l Build a claim file import format
l Build a fixed-width import format (for payments and adjustments)

2. Creating import batches
l About import batches
l Create an import batch

3. Adding files to the Import Task List

4. Auto-importing to the system

5. Viewing import activity

2
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Build a claim file import format
Typically, Kaufman Hall implementation specialists set up and maintain needed formats during the initial
setup process. These formats are built and maintained in Axiom Contract Management from a .NET-
based import utility program called UnifiedImport.exe. This utility allows the system administrator to
build new import formats, edit existing formats, and build and schedule batches for import.

The acceptable claim types that require you to build a format are:

l UB92
l UB04
l HCFA 1500

To create a new claim format:
1. Run UnifiedImport.exe.

2. From themenu bar, select Import Setup, then select Spec Imports.

3. From the System drop-down, select CMA and then select the import type.

In the following example, we are creating a format for the UB04 print image.

4. Select the sample file to use to build the format. To build a format, you need to use a sample file
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that tells the system where all the fields are loaded.

NOTE: The sample file name and path cannot include print characters, headers and footers,
and must be in a subfolder with the path \\YOURSERVERNAME\Data\Import.

5. After selecting your file, click theNew button to create a new file, or click Edit on any existing
format already created. In the following example, we are creating a new format.

6. Enter the Format Code, Description, and then select Top of Page Text.

Each format must have a unique code assigned to it.

7. Enter a 4-character code and a description of your format, then select the text that defines the Top
of Page Text.

IMPORTANT: Axiom Contract Management determines that a claim is new by reading in the
“Top of Page Text” in an import file. The system searches for a unique occurrence of this text
string and sets that line as the starting point marker for the next claim. All other fields defined
in your format are offsets of this text, so it is critical that it is unique and consistent across your
claims. Typically, the Top of Page Text is defined as the provider name, but in some cases,
address line 1may be an acceptable value. Anything above the Top of Page Text line will not be
imported for a particular claim.

a. To define the Top of Page Text, select it in the claim previewwindow as shown in the
following example, and then click Accept. After specifying Top of Page Text, Primary Payer
Code, Patient Control Number and Bill Type, the system automatically populates the
locations of all the remaining fields in the system. Ensure that each field is lined up properly
on the format.

b. To verify the remaining fields, click the field name and check the highlighted area in the
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claim previewwindow.

8. Define the fields for import. Axiom Contract Management also allows you to import additional
information such as User Defined Fields, UCRN code, and DRG. To bring this information in, you
must specify it in your format.

a. To define a field, select it from the fields list on the left side, then select it in the claim
preview pane and click Accept.

b. Revenue Code Details, Procedures and Diagnoses and Other UB fields are consolidated into
three format subsections. To set these fields, you must select each section and specify the
field locations.

9. Verify your Format. After the system determines your fields, you must verify their locations. In
some cases, the claim in the preview panemay not have all the fields that you want to specify. If
this is the case, you can toggle between claims in the file by clicking New Claim and Prev Claim.

IMPORTANT: It is critical that you verify all formats before importing. The UB04 and 1500
format builders all work in the sameway.

Build a fixed-width import format
Fixed-width import formats are generally used for importing payments and adjustments data to Axiom
Contract Management in fixed-width ASCII text files. To get the information from these downloads into
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the system, you need to build a format for them as well. Their formats are different from a claim format
in that the data is provided in fixed columns instead of floating fields, like on a claim file. Flat File Import
formats are required for dealing with these files.

To create a file format:
1. Run UnifiedImport.exe.

2. From themenu bar, select Import Setup > Spec Imports.

3. In the System drop-down, select CMA.

4. From the Import Type drop-down, select Fixed.

5. Select Folder Based Import.

6. From the Table Name drop-down, select the name of the Import Table. In the following example,
a format is being defined to import to the CMAPostings table.

Axiom Contract Management Flat File Tables are categorized as follows:

l CMA Postings – Payments, Adjustments, etc.
l CMA Library Tables – Library APC, DRG, etc.
l Additional Data Upload – DRG, User-Defined Data, Payer Code, etc.

By selecting CMA as the System, and in this example, CMA Postings, you are setting up the system
to create a CMA Postings format.

7. Select the Import Folder Location. As with print image formats, you need to select a sample file to
build flat file formats.
Click the ellipsis button next to Import Folder and select the folder where your sample file is
located.

IMPORTANT: This samplemust be free of print characters, headers and footers, and must
reside in a subfolder with the file path: \\YOURSERVERNAME\Data\Import.

8. Create a new format: Click New to open the format building windowwith the sample data for
selection, as shown in the following example.
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9. In the fields at the top of the window, enter a format name and description.

10. On the lower left, in the Fields box, select the field to specify, and then select the data location in
the Field Selection box.

11. Click Accept to save the values to the database.

NOTE: Fields in bold are considered required fields and must be specified. Fields in italics have
already been specified.

12. After completing the format for your flat file, click Save.

� Advanced flat file import options
When building an Axiom Contract Management Postings format, set up Advanced Options for the
following fields:
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Amount Field
l Decimal Settings – Use this option to set whether the amount field in your file uses a space

decimal, implied decimal, or normal decimal. Depending on the way the amount field is provided,
you must select the appropriate DecimalFunctionID. Following are examples of each:

Space Decimal: 100 00→ 100.00

Implied Decimal: 10000→ 100.00

Normal Decimal: 100.00→ 100.00

l Negative placement – In some cases, negative signs (-) are attached to the front of the amount,
and in others, they are attached at the end.

IMPORTANT: For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any
accounts.

l Reverse sign – For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any accounts.

l Post Category – Adjustment vs. Payment

l Post Prof Indicator – Professional vs. Institutional

About import batches

What is an import batch and why is it needed?
When formats are built using the format builder, the next step in importing data to the system is creating
import batches. These batches are groups of tasks that tell Axiom Contract Management where to look
for files, and once found, which formats to apply to them. You must create an import batch to get data
into the system. You need to create batches for claim files and any flat files that you want to import.
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� Folder based vs. file based
Themost common setup for importing data is the folder-based import. A format is joined with a folder
location, and upon import, any file residing in that folder is brought in using the set format code.

IMPORTANT: All import folders must be subfolders of \\YOURSERVERNAME\Data\Import, and must
not have any spaces in the folder or file name.

After importation, the file is datetime stamped and moved into a mirrored IMPORTED folder for later
reference if needed.

The same restrictions apply for file-based importing. Themain difference is that instead of setting a folder
to import, you select a single file.

Create an import batch

Import batch types
Before creating an import batch, you need to understand the following different types of batches used in
Axiom Contract Management:

l UB92 – Folder and File Based
l UB04 – Folder and File Based
l 1500 – Folder and File Based
l Flat File Import – Folder and File Based

To create an import batch:
1. Select the import type. An import batch can be created for each of the import types. Select the

appropriate import type from the drop-down menu.

2. Name and create your batch. Click Create to create a blank batch for the import type selected in
step 1.
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3. Select files/folders to import and the target table to import to. On the left side of the screen, from
Table Name drop-down, select the target table.

4. Click the ellipsis button next to Import Folder, and select the import folder or file location.

5. In the Format box, select the format to apply to the folder.

NOTE: Only one format can be applied to a folder.

6. Add your item to the batch. Click the right arrows button to add your item to the batch selected in
the drop-down on the right side of the window. To remove an item from the list, select it and
press theDelete key.

IMPORTANT: Do NOT click the Delete button. Clicking the Delete button will not remove an
item from the list, but instead will delete your whole batch.
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Add import batches to the Import Task List
After creating import batches, to process them during the import, you must add them to an import
queue known as the Import Task List. Simply creating the batches does not cause the files and folders in
those batches to import automatically.

To add or remove items from the Import Task List:
1. From themenu bar, select Import >Manage Tasks.

2. Create and define a Task Group:

a. At the top right, click the Create New button.

b. From the Batch Types drop-down, select the batch type, and then click the arrow buttons
to add the batch types to the Task Group on the right.

In the example below, the Task Group “Example Task Group” is defined with a number of
batch imports of various types. These will all run when the Task Group is called by the
import process.

About auto-importing
All data entering the system runs through Kaufman Hall’s auto-importer, which generally runs four to
seven days per week. It usually runs late at night or early in themorning so that it does not interfere with
work being done by users. When the import completes, if successful, you will receive an email confirming
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the import and detailing the contents. The following is a list of terms, with accompanying definitions,
found on the report.

� Import Summary Report definitions – CLAIMFILES
l Batchnumber – System # assigned to each import file
l Import File Name – Name and import location of file
l # of Claims Read into Temp – In Axiom Contract Management, all claims are loaded to a

temporary staging area before being transferred into the LIVE environment. This allows us to run
validation processes on the data to ensure the data is correct. This # should tie to the # of billed
claims in the import file.

l # of Late Charge Records – Details howmany late charges were in the import file
l # of Claims Rejected to Bad – In cases where bad data is provided, the system removes the

records associated to the bad claim and moves them into a separate area. You can run the Bad
Records report to check why any claims weremoved there. Reasons vary as to why a claim would
bemoved to bad, but most of the time it is related to missing required data elements (e.g.,
account #), a number that has a character in it and the system cannot convert it correctly, or a bad
date that does not convert. You should rarely see anything detailed in this field. If you do, run the
bad records report or contact support@KaufmanHall.com.

l Valid Claim Total Charges – This field provides the total charges of the claims that were
successfully imported to the Live environment.

l # Claims Transferred to Live – This field indicates howmany of the temp records were imported
to the Live environment. It should be in line with the # of claims read into temp column (unless
records weremoved to bad).

l # Claim Exceptions – In some cases, imported claims aremarked as exceptions. Following are
reasons for exception records:

o Trying to insert a series bill over an existing non-series bill claim
o Trying to insert a late charge onto a series bill
o Trying to insert a void over a series
o Trying to insert a non-series bill over an existing series bill
o Invalid Medicare Part B Type of Bill
o Trying to insert a zero payment bill into the system
o Trying to insert over higher charge claim
o Voided Claim
o Invalid Late Charge Bill (Incompatible Bill was imported after this record)

The second sheet of the import summary report details all the exceptions from the import,
including the Bill ID (Patient Account Number) linked to the claim in the system. In addition to Bill
ID, the supplementary details include: Batch Number, Import File Name, Exception Reason, Bill
Code, # of Claims, and Total Charges.
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l # of Claims Grouped – Axiom Contract Management groups all outpatient claims into their
corresponding APCs based on the date of the episode of care and its corresponding version of the
Medicare APC schedule.

l # of Claims Priced – Any Medicare-based outpatient claim will price against the 3M pricer if factors
have been provided to Kaufman Hall and a corresponding calculation schedule has been built and
validated. Please email your factors to support@KaufmanHall.com.

l # of Claims Calculated – This field indicates the # of claims that found a contract and calculated
accordingly.

� Import Summary Report definitions – POSTINGS
l Batchnumber – System assigned # to each import file
l Import File Name – Name and import location of file
l # of Postings Read into Temp – In Axiom Contract Management, all claims are loaded into a

temporary staging area before they get transferred into the LIVE environment. This allows us to
run validation processes on the data to ensure the data is correct. This # should tie to the # of
posting records in the import file.

l # of Postings Rejected to Bad – In cases where the data is bad, the system removes the records
associated with the bad claim and moves them to a separate area for review by support staff.
Reasons vary as to why a posting would bemoved to bad, but most of the time it is related to a
missing required field value, a number that has a character in it and the system cannot convert it,
or a bad date that does not convert. You should rarely see anything detailed in this field. If you do,
please contact support@KaufmanHall.com.

l Duplicates – Duplicate files aremoved to a Duplicates folder.
l # of BillIDs Imported – This field provides the number of unique account numbers in the posting

file being imported.
l # of Matching BillIDs – This field provides the number ofmatching billIDs found in the Live

environment for the postings being imported.
l Total Valid Postings Amount – Provides a summary of the valid posting records being imported.

NOTE: If any records are rejected to bad, their amounts are not reflected in the Total Valid
Postings Amount.

View import activity
To view your import activity:

1. Log in to the Axiom Contract Management Web Client.

2. In themain menu header, click Import Data and select View Batches.
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TheManage Import Batches page opens.

Manage Import Batches page example

On theManage Import Batches page, you can view all data entered in the system, organized by
batch (1 file = 1 batch). This is useful when looking at the View a Claim Summary tab, where the
batch number is provided, and you want to locatemore information about that batch.

Each claim batch has the following information columns:

l Import Date
l Type (type of claim)
l Batch #
l File Location
l Claims Submitted (number of claims)
l # Rejected
l # Accepted
l # Exceptions
l # Calculated
l Total Charges
l Notes – This column contains notes about the imported file; for example, if a file was not

imported because it is a duplicate, that is noted here.

3. To view batch information for Postings and other file imports, from the Select Import Type drop-
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down, select Flat File Imports.

Flat File Imports include Payments and Adjustments, as well as any Additional Data files you
submit, such as DRG or Plan Code Files.

Some information is not available if the batch was imported as part of a historical data import.

TIP: In every view, the bottom right corner contains page navigation options. Click the arrows
to move to the next/previous page, or you can jump to a specific page by selecting it from the

drop-down:

IMPORTANT: Do NOT delete batches unless instructed to do so by a member of the CMA
Support Team. If the batch information is deleted, it cannot be recreated.

Access Contract Management data in the AxiomDesktop
Client

Key Axiom Contract Management assets are available in the Axiom Software platform so that Axiom
Contract Management system administrators can pull and synchronize key contract, claim, and
calculated claim-level estimated payment details for use in the Desktop Client. This integration allows
users to take advantage of Axiom tools like the Axiom Scheduler Jobs Library and Axiom Reports.

During Contract Management installation, data is pulled from Axiom Contract Management and stored
in the following Axiom tables in the Table Library:

l CM Claim level estimated payment
l CM Claim Numbers
l CM Contract Details
l CM Last Import

In addition to the tables, a newAxiom job, called Import Claim Level Estimated Payment, is created in the
Axiom Scheduler Library under Contract Management. This job helps share data from Axiom DSS with
Axiom Contract Management.
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When this job runs, it retrieves all of the contract detail, claim-level expected payments, and claim detail,
and uses it to update the four CM tables and keep the data in sync. Whenever users import new claims,
modify claims, calculate a payer, and so on, this job captures these changes when it runs. Generally, this
job would be set to run with the full nightly import (CMA Full Import job).
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Managing attributes
Attributes are custom tags that allow you to extend contract data models. Attributes allow you to add
information to a contract that exists on the physical contract but for which theremay not be room in the
modeled version.

l Attributes can be applied to claim and line-level reporting to enhance understanding of contracts
and calculation performance.

l Attributes provide a way for you to define, organize, and categorize all levels of a contract model.
l Attributes enhance the reporting and analysis of contract calculations.

Only users who have permissions to model contracts can add attributes to contracts.

As a system administrator, you create and manage system attributes on the Attributes page, accessible
from the Admin menu on themain toolbar.

Overview of Attributes page

3
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Creating attributes
Attributes available to users depend on what level of the contract the user is at when they add the
attribute. If a user is adding an attribute at the contract level, the only attributes available to select will be
Contract type attributes. This means that when you create attributes, think about what kind of data the
attribute should hold, and at what level of the contract the attribute should be applied.

Only system administrators can create attributes.

� Create an attribute
Use these instructions for creating attributes that do not contain pick lists.

To create a non-Library data type attribute:
1. In themain menu header, click Admin > Attributes.

2. On the Attributes page, on the upper right, click Create New Record.

The Create newAttribute form opens.

3. In the Attribute name, type a name for the attribute.

4. In the Attribute Description field, type a description for the attribute.

5. From the Attribute Data Type drop-down, select one of the following:

NOTE: You cannot change an attribute’s Data Type after saving the attribute.

l Integer – Creates a field that accepts a number
l Money – Creates a field that accepts dollar and cents amounts
l Decimal – Creates a field that accepts decimal values
l Percent – Creates a numerical field that accepts percentages
l Text – Creates a text field for the user to enter text
l Library – Creates a list from which a user can select values. To create this type of attribute,

see Create a Library attribute.

6. From the Attribute Type drop-down, select which part of a contract the attribute should be
applied to:

NOTE: You cannot change an attribute’s Type after saving the attribute.

l Contract
l Version
l Provision
l ClauseTerm

7. To make this attribute available for immediately after creation, click the Enabled check box.
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8. Do one of the following:
l If you selected the attribute data type Library, click Save. When the page refreshes, click the

Edit Library button to the right of the grayed out Attribute Data Type field.

9. Do one of the following:
l To save but remain on this page, click Save.
l To save and exit this page, click Save and Close.
l To save and create another attribute, click Save and New.

� Create a Library attribute
Library data type attributes allow you to create a list users can select from when applying the attribute.

To create a Library data type attribute:
1. In themain menu header, click Admin > Attributes.

2. On the Attributes page, on the upper right, click Create New Record.

The Create newAttribute form opens.

3. In the Attribute name field, type a name for the attribute.

4. In the Attribute Description field, type a description for the attribute.

5. From the Attribute Data Type drop-down, select Library.

6. From the Attribute Type drop-down, select the contract part the attribute should be applied to.

NOTE: You cannot change an attribute’s Type after saving the attribute.

7. To make this attribute available for selection immediately after creation, click the Enabled check
box.

8. Click Save.

The page refreshes to show an Edit Library button to the right of the Attribute Data Type field.

9. Click the Edit Library button.

10. In the Attributes Librarywindow, click Add new record.

11. In the Library Value field, enter the first item for the pick list in the field provided, then click
Update. The item is added to the list.

12. Click Add new record again to add a second item to the pick list. Enter the second item in the field
provided and then click Update. Repeat this step until you have added all the desired items.

13. Click the X in the upper right corner to close the window.

14. On the Edit Attribute page, click Save and Close to save and exit the page, or click Save and New
to save and then create another attribute.
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Edit or delete an attribute
Only System administrators can edit or delete attributes.

Editing includes:

l Changing attribute names and values,
l Disabling or enabling attributes
l Deleting attributes

NOTE: You cannot change an attribute’s Data Type or Type. However, you can edit pick list entries
for Library data type attributes.

To edit or delete an attribute:
1. In themain menu header, click Admin > Attributes.

The Attributes page opens.

2. To edit an attribute, click the Edit button at the end of the attribute’s row and then do any of the
following:

l To disable an attribute so that it cannot be used, clear the Enabled check box.
l To change the name, in the Attribute Name field, type changes.
l To change the description, in the Attribute Description field, type changes.
l To change the pick list selections for a Library data type attribute:

a. To the right of the Attribute Data Type field, click the Edit Library button.
b. To edit an entry, click the Edit button for the entry, make desired changes, and then

click Update.
c. To add a new entry, click Add new record, and then enter a value, then click Update.
d. To delete an entry, click theDelete button for the entry, and then click OK in the

confirmation dialog.
e. Close the Attributes Library window.

3. To delete an attribute:

NOTE: The recommended best practice is to disable an attribute rather than deleting it.

a. Verify that the Enabled column is blank. If it reads “true,” then click the Edit button and
clear the Enabled check box, then save the attribute.

b. Verify that the attribute is not currently attached to any contract or contract items.

c. At the end of the attribute’s row, click theDelete button.

d. In theDelete confirmation dialog, click Yes.

4. Click Save.
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Modeling contracts
Axiom Contract Management stores contract terms, patient claims, and payment information. The
system uses the contract payment terms and the patient claim information to calculate an expected
payment for every claim submitted by the provider. After the claim is paid by the primary payer, it can be
compared to the expected payment and/or the expected contractual to see if the claim was reimbursed
according to the agreed upon contract terms.

Contract data requirements
For expected payments to bemodeled accurately, the contract terms must be entered correctly in Axiom
Contract Management. To accomplish this, you need a thorough understanding of the contract
language and terms as well as access to electronic fee schedules, and any other data relevant to building
a model of the signed contract. For Medicare-based contracts, you need hospital-specific factors
provided to the hospital by either the Fiscal Intermediary (FI) or by CMS directly. Often this requires
direct contact with the payer representative.

You then need to interpret these terms into Axiom Contract Management, with the understanding that
Axiom Contract Management uses specific logic to calculate a claim. This logic is discussed in the rest of
this section on building contracts.

Filter contracts on the Contracts page
You can filter the list of contracts on themain Contracts page.

To filter contracts:
1. If the desired simulation is not currently selected, select it from the Current View drop-down.

2. Type the name or the first few letters in the name or any word in the name, into the filter field, and
then click Filter.

4
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The list filters to your input:

3. To clear the filter, delete the text in the filter box and then click Filter.

Add a contract
The following instructions are for creating a new contract from scratch.

To add a contract:
1. On the Contracts page, check that you are in the desired simulation. If you are not, then from the

Current view drop-down, select the desired simulation.

2. In themenu on the left, click New Contract.

A new row is added to the bottom of the list of contracts.

3. In the new row, type a name for the contract (e.g., Medicare Blue Cross). Do not use special
characters.

4. Click Save.
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You do not need to enter the latest expiration date in this area because that is defined by the
versions built under the contract.

5. (Optional) If desired, add an attribute to the contract.

6. Next, add a version to the contract.

Add a version
After creating a contract, adding a version is the next step in building a contract. Instead naming them,
versions are identified by their time frame.

To add a new version:
1. On the Contracts page, select the contract by clicking in the blue column for the desired contract.

TIP: If the list of contracts is long, use the filter at the top right of the page to filter the list.

2. In themenu on the left, click New Version.

A new row is added to the list of versions.

3. To assign the start date, click in the Start Date cell, and select a date from the drop-down.

� About Start Date / End Date
In Axiom Contract Management, a version is a defined time frame for the contract. The time frame
used can be from the time period on a certain contract where the terms remain consistent. It can
represent the fiscal year, or it can represent the calendar year. To minimize the number of
contracts built, we recommend that you build versions defined by contract periods where terms
remain unaltered.

4. To assign the end date, click in the Expiration Date cell, and select a date from the drop-down.

5. Assign the calculation date for the version—either the date of discharge or the date of admission.

� About Contract Calculation Date
You have two options when calculating claims: you can choose to calculate them by the date they
were admitted (Admit), or by the discharge date (Discharge).

The one you use depends on the payer, which you should confirm with them. The default is by
discharge date.

6. Click Save.

NOTE: You need to save the version before assigning version organization codes.
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7. In the Ins. Plan Code column for the version, click the Set button.

The Insurance Plan Code window opens.

The Available Insurance Plan Codes list displays in the lower half of the window. This list is based
on the facility (org code) hyphenated with the insurance code associated with the plan.

8. Do one of the following:
l Import insurance plan codes from another version.
l Continue to step 9 to add codes from the list.

9. In the Available Insurance Plan Codes section, select the org code - payer code combinations to

add to the version by clicking the up arrow button ( ) to the left of the organization to add.

l If the plan has more than one Org associated with it, before selecting codes, click the
Filtered by Org drop-down, and select the organization from which to select codes.
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NOTE: Administrators can add newOrg codes to the system. For more information, seeMap
provider names to Org codes.

� Assign Version Organization Codes
For a claim to calculate on a contract, Axiom Contract Management must knowwhich payers
calculate against the version.

10. Click Save/Exit.

New version added to contract

11. After making selections, click Save.

12. (Optional) If desired, add an attribute to the version.

13. If you are building a contract, the next step is to add a provision.

Import insurance plan codes to a version
When creating or editing a contract version, you can import Insurance Plan Codes from an existing
contract.

To avoid calculation and reporting problems, the insurance plan codes must not overlap. The system
checks for an overlap in the plan code dates. If there are none, the codes are imported; otherwise you
will receive a warning. If there are overlapping code dates, you need to determine which payercodes
overlap across versions and fix the issue before the system will let you import the codes. You can adjust
the dates of the versions or payercode assignments on the versions to ensure that an overlap is not
created.

To import insurance plan codes to a version:
1. Navigate to the version for which you are adding codes.

2. In the Ins. Plan Code column, click Set.

3. In the Insurance Plan Codewindow, click Import.
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4. In the Import Insurance Plan Codes window, locate the version with the codes you want, and
then click the check box.

5. Click Import.

6. In the confirmation dialog, click OK.
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The imported codes display in the Insurance Plan Code window of the target version.

NOTE: If you copy codes you do not want, you can remove them by clicking the box to the left
of the code and then pressing theDelete key on your keyboard.

7. Click Save/Exit.

Add a provision
You can add a provision to a contract by creating a new one, by converting (copying and editing) an
existing one, or by importing one. The following instructions are for creating a new provision.

TIP: Use this option when there is no similar provision to copy or import.

To create a new provision:
1. On the Contracts page, navigate to the contract. If the Contract list is long, filter the list.

2. In the Version list, click theDetails link for the desired version.

The Provisions page displays.

3. In themenu on the left, click New. The Provisions Settings window opens.

The Provisions Settings window contains the options for selecting the Type of Bills to calculate
under the provision. For example, if both the inpatient and outpatient contracts pay 75% of
charge, you can create one contract provision to handle both bill types. The provision’s purpose is
to select the bill types that calculate similarly under a specific date range.
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4. Click the plus symbol ( ) to the left of the desired Type of Bill to expand its options, then select
the bill types to be applied by the provision.

5. Click Add Provision.
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6. At the Provisions page, click Save.

7. If needed, enter provision factors manually or import factors from a file or other provision.

8. (Optional) If desired, add an attribute to the provision.

About provision factors
Provision factors are used in various CMS calculations. Certain factors, along with other contract rules
related to modifiers, are required for APC contracts.

Some of the factors are considered National Factors (i.e., Labor Related Standard Amount, Federal
Capital Rate, etc.), which means that they are the same across the nation. Some factors are Hospital
Specific and can only be answered by the hospital’s Medicare Specialist to whom notices are sent when
the factors are changed, or when a new fiscal year begins and all factors have changed. Any box tagged as
“Release” cannot be entered manually and will be updated when rates are attached to the clause or
term.

To use any CMS-related calculation basis (i.e., CMS DRG, CMS Psych, CMS CMG, or Schedules related to
CMS), you must complete the factor forms. You can add the following types of provision factors:

l CMS DRG – Add hospital and federal values specific to the date of the provision and used within
the calculation of inpatient services that are paid using a code called a DRG.

l CMS Psych – Add hospital and federal values specific to the date of the provision and used within
the calculation of inpatient Psych services.

l CMS CMG – Add hospital and federal values specific to the date of the provision and used within
the calculation of inpatient Rehab services.

l Schedules – Select 3M schedules for Outpatient services that are paid with APC (Medicare) or
eAPG (State specific Medicaid). These schedules contain the hospital-specific and federal values
appropriate for the date range of the provision.

l Modifiers – Enter modifier values used in line-level calculations within the provision. Lines with
modifier codes are calculated using thesemultipliers.

Assign a schedule to a provision
Use these instructions to assign a schedule to a contract provision.

To assign a schedule to a provision:
1. In the desired simulation, navigate to the provision.

2. On the Provisions page, in the Factors column, click the Set button (or, to change the selected
schedule, click View).
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3. In the Factors window, click the Schedules tab.

4. From the Select the reimbursement type drop-down, select the kind of reimbursement the
provision uses. This selection determines the schedules available in the next drop-down.

5. From the Select a schedule drop-down, select the desired schedule.

6. Click Save.

Manually enter provision factors for CMS calculations
Use these instructions to add CMS provision factors to APC contract versions.

To add factors to a provision:
1. Navigate to the desired provision.

2. In the Factors column, click the Set button (or, to modify a provision, click View).
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3. In the Factors window, click the tab that corresponds to the type of calculation (CMS DRG, CMS
Psych, CMS CMG).

4. In the desired CMS tab, enter amounts in the fields provided, as needed.

NOTE: Fields with names followed by a red asterisk are required for calculated payment. Fields
with names followed by a red cross require you to enter percentage amounts as decimals.

5. If needed, select high-dollar outlier exclusions.

6. Click Save, and then click Exit.

Import and export provision factors
When copying or creating contract provisions, you can import DRG CMS, Psych CMS, or CMS CMG
factors from a file or from another provision instead of populating the factors fields manually.
Additionally, you can export factors to an Excel file.

� Import provision factors from another provision
To import provision factors from another provision:

1. Navigate to the provision for which you are adding factors.

2. In the Factors column, click Set.

3. In the Factors window, at the bottom, click Import.

4. In the Import Factors window, do the following:
a. If needed, from the Simulation drop-down, select the desired simulation.

b. Expand the contract and version with the desired provision and factors, and then select the
check box for the desired provision.

c. At the bottom of the window, select the check boxes for the factor types to import.

d. Click Import.
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e. In the confirmation dialog, click Yes.

The factors display in the Factors window’s corresponding CMS tabs for the type(s) of factor(s)
imported.

5. Click Save, then click OK in the confirmation dialog.

� Import provision factors from a file

NOTE: Excel files used to import factors need to adhere to a specific format. To ensure your file is
formatted correctly, download the template and enter or copy the desired factor information to it,
then save and import it using the following instructions.

To import provision factors from a file:
1. Navigate to the provision for which you are adding factors.

2. In the Factors column, click Set.

3. In the Factors window, at the bottom, click Import.

4. In the Import Factors window, do the following:
a. Click the Import From File tab.
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b. If needed, on the right side of the window, click Template to download the template.
Complete the information in the template, then name and save it. Or, you can import
factors that you exported from another provision to an Excel file.

c. In the Import from section, select one of the following:
l Single File – To import from a single file.
l Multiple Files – To import from multiple files.

d. Click Choose File and select the formatted and populated Excel file.

e. Click Import, then in the confirmation dialog, click OK.

The factors display in the Factors window’s corresponding CMS tabs for the type(s) of factor(s)
imported.

5. In the Factors window, click Save, then click OK in the confirmation dialog.

� Export provision factors to an Excel file
To export provision factors:

1. Navigate to the provision with the factors to export.

2. In the Factors column, click View.

3. In the Factors window, at the bottom, click Export.

The data is exported to an Excel file at the bottom of your screen. Data is exported from all three
CMS tabs. If no data exists for a CMS tab, then in the Excel file, that tab displays with headings
only but no data. The file is automatically formatted correctly for importing to another provision.
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4. Click the file to open and save it.

Select high-dollar outlier exclusions
To accurately model changes made to the Inpatient CMS DRG calculation, you may need to determine
the high-dollar outlier exclusion amount. To exclude high-dollar charges like transplant acquisition
charges or coagulation factors from the CMS DRG outlier determination, you can specify the Line Item
codes or Rev Codes associated with these charges to exclude them from the outlier determination within
the CMS DRG calculation. Use the Exclusions windowwhen defining a provision for APC and eAPG
contracts.

After selecting the exclusions, you add a clause or term with the CMS DRG calc basis, and then attach
DRGs and other required DRG-related elements. When incoming claims are processed against the CMS
DRG calculation, if a claim has any CMS DRG items that match the clause or term on the provision, the
system inspects the lines on the claim for the selected exclusion codes. The system totals any claim items
that match the exclusion codes and then subtracts this amount from the total charges when determining
the outlier portion of the CMS DRG calculation.

To specify high-dollar exclusions:
1. On the Contracts page, navigate to the desired contract version, and then click theDetails link for

that version.

2. On the Provisions page, in the Factors column for the desired provision, click the Set button (or,
to modify the provision, click View).

3. At the bottom of the Factors window, click Outlier Exclusions.

The Outlier Exclusions window opens.
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4. At the top of the window, select the exclude option:
l Rev Code – Select exclusion items by rev code.
l Line Item Code – Select exclusion items by line item code.

NOTE: You can select only one option.

5. In the lower half of the window, locate the item(s) to exclude, and then click the up arrow button (

) to the left of each item to move that item to the top half of the window, as shown in the
following example.
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6. Click Save and Exit.

Using attributes
Attributes are custom tags you add to contracts and contract levels (i.e., versions, provisions, and
clauses/terms) to:

l Extend the contract data model – Attributes allow you to add information to a contract that exists
on the physical contract but for which theremay not be room in themodeled version.

l Organize key aspects of payer contracts
l Enhance reporting across contracts and payers
l Augment reporting for current calculations and modeling detail
l Ensure key details are collected during contract building

Attributes are applied at the contract, version, provision, and clause/term level. You can attach an
attribute from the list of attributes for that contract level or you can import an attribute from another
contract.

Users who have permissions to model contracts can add attributes to contracts.

Attribute data:
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l Name – Attribute’s name
l Description – Explanatory information about the attribute
l Data Type – The format of the attribute’s data value (i.e., text, integer, percent, etc.). For example,

if the Data Type is text, then the attribute’s value field accepts only text entries.
l Attribute Type – The contract level at which the attributed can be used (i.e., contract, version,

provision, clause/term)
l Enabled/Disabled –Whether or not the attribute is available for use. If an attribute is disabled by

the system admin, it will not display in any attribute selection lists.

Add an attribute to a contract level
These instructions are for adding attributes to contract levels (i.e., contract, version, provision, or
clause/term). When adding attributes, you can add only attributes of the type that corresponds to the
contract level. For example, you can only add version attributes to versions, and clauses/terms
attributes to clauses or terms.

To add an attribute to a contract/version/provision/clause/term:
1. Navigate to the desired contract and level.

2. In the Attributes column for the level, click Add.

A window containing available attributes for that type of contract part opens. The following
example shows a selection window for provision attributes.

Administrator's Guide Axiom Contract Management │ 56



Example of Provision attribute window

3. For the desired attribute(s), select or enter a value in the field.

4. Click Save, then click Close.

5. Save the version.

Import and copy an attribute
These instructions are for adding attributes to contract levels (i.e., contract, version, provision, or
clause/term) using the import function.

To import and copy an attribute from one contract to another:
1. Navigate to the desired contract and level.

2. In the Attributes column for the level, click Add.

A window containing available attributes for that contract level opens. The following example
shows a selection window for provision attributes.

3. Click the Import Values tab.

4. To import from a different simulation from the one you are in, select the desired simulation from
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the Simulation drop-down.

5. From the Contract drop-down, select the contract that has the attribute you want to copy.

6. From the [Level] drop-down, select the desired item. For example, if you are copying from a
version, select the version number, as shown in the following example.

7. Click Import. The selected tab switches to the Set Values tab.

8. In the Set Values tab, for the desired attributes, you can either accept the existing values or
change them.

9. Click Save and then click Close.

10. Save the item you added the attribute to.

Administrator's Guide Axiom Contract Management │ 58



About bill types
What is a Bill Type, and why is it important?
The Bill Type, or Type of Bill (TOB), is a three-digit numeric code on the claim that identifies the specific
type of bill being sent to the payer. The first digit represents Type of Facility (Hospital, Skilled Nursing,
etc.), the second digit represents the Bill Classification (Inpatient, Outpatient, etc.), and the third digit
represents the Frequency (Admit/Discharge, Late Charges, Series, etc.).

The TOB submitted on the claim is important not only for filtering which provision the claim will calculate
on, but also for how the claim is handled during import. For every patient account, the importing logic
first checks whether the account already exists in the system. If it does, the system applies a series of
logical statements and the instance of the claim is brought in as Active, an Exception, or a Voided Record.
All claims are brought in as the Active claim if no other instance of the claim exists, and as long as the
claim is not a Late Charge (i.e., TOB XX5) or a Voided Record (i.e., TOB XX8).

A Late Charge is always brought into the system as an Exception Record. If an active record exists for that
patient account, the late charge is attached to the active claim and the line items from the late charge are
appended to the active record. If no active record exists, the late charge claim sits idle as an Exception
until an active record is brought in for that particular account number. At that time, it appends to the
newly imported active claim.

Series TOBs (i.e., XX2, XX3 and XX4) are handled differently. If a Series Start bill (i.e., XX2) already exists in
the system and another is imported, the imported one becomes the newActive claim and the previous
instance is considered Replaced. The same applies to a Series End TOB (i.e., XX4). Multiple Series Interim
bills can exist on a claim; however, if an XX3 comes in and has the same admit and discharge dates as a
previous XX3, as well as the same total charges, it will replace thematching instance.

The standard Admit/Discharge claim (i.e., XX1) always comes in as active, and replaces the existing active
record as long as the charges are equal to or greater than the current record. The claim comes in as an
Exception if total charges are less than the existing claim. A Replacement claim (i.e., XX7) always replaces
the existing active record no matter what the total charges are for the claim, and regardless of whether or
not there are late charges appended to the current record.

Replacement and Late Charge claims are not allowed with Series claims. Both come in as Exception
records if a series TOB exists on the account. The reverse is true as well. Series claims are not allowed on
non-series accounts.

Clauses and terms
Clauses and terms are provision building blocks. They are the vehicle that defines contract terms, rates,
and limits. A clause and term are interchangeable in how they calculate; however, a term always resides
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beneath a clause. The clause is considered the parent of the term. A clause can have no terms or it can
havemultiple terms. A term always has the one clause under which it resides. The order and the
selections made on a clause/term determine how the claims filter through the calculation criteria.

� Clause and term order significance
Axiom Contract Management calculates claims in a top-down manner for both clauses and terms. This
means that a claim initially tries to match to the first clause listed in the provision. If there is no match, it
continues on to the next clause, regardless of whether or not a term exists on clause 1. If, on clause 2, the
claim matches the defined criteria, it stops and makes the calculation. Then it continues on to the first
term of the clause (if it exists), and then the second term (again, if it exists) beforemoving on to clause 3,
and so on. The only way to stop a claim from moving to the next clause (or term) is to set it as terminal.
For information on changing the order of a clause or term, see Edit or delete a clause or term.

� Clause or term Calc Basis
The following example shows some of the possible selections for the clause/term calculation basis. You
cannot edit these. The calculation basis is used in conjunction with the calculation type and measure to
determine a specific reimbursement method.

Calc Basis paired with the rates loaded for the clause or term determine whether a claim will qualify. For
example, if Admit Diagnosis Code is selected, Axiom Contract Management only finds claims for which
the defined clause/term codes match the admitting diagnosis code on a claim.

The CMS-based options include specially built calculation rules that are used with the defined factors for
the Provision. If you select a CMS calc basis, the type and measure drop-down boxes are automatically
disabled.

Certain basis options are considered Claim level and some are considered Line Item level. Selecting one
or the other defines the options available for Calc Type and Measure. For example, DRG is considered
Claim level, whereas RevCode is considered a Line Item level calculation basis.
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Calc Basis options available from the Calc Basis drop-down

� Calc Type
There are three possible selections for the Calc Type field. Either the clause/term will be paid at a Dollar
Rate, a % of Charge, or a % of Cost, with the first two selections being themost commonly used. The calc
types available for selection are determined by the Calc Basis selected.

� Calc Measure
The five possible selections for the Calc Measure field are: Per Claim, Per Diem, Per Date, Per Line Item,
and Per Line Item Qty. These options are limited based on the Calc Basis selected for the clause/term. For
example, if DRG is selected as the Calc Basis, the option for Per Date, Per Line Item, and Per Line Item Qty
are not applicable, as those are used with Line Item level parameters only.

� Terminal vs. Non-terminal
Setting a clause or term as terminal or non-terminal (the default) determines if a claim will continue
calculating on the clause or term below it.

Setting a clause to Terminal (i.e., Yes) stops the claim from progressing to the next clause; it does not
stop it from moving through all of the terms (if any) below that clause.

Setting a term to Terminal stops it from progressing to the next term under the same clause; it does not
stop it from moving through any clauses (if any) below it. For the terminal logic to apply to a claim, it
must qualify on the defined calculation criterion for the clause or term.
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For example, if a claim has an implant revenue code, a certain dollar amount will apply to that rev code
line item for all claims, and even if a claim qualifies for this payment, it will continue down to the next
clause. If the claim qualifies for Orthopedics, it stops there, and Orthopedics will be the only other
possible payment method on the claim, as that is a terminal clause. If it is not an Orthopedic claim (based
on the defined DRG), it will continue on. If a claim qualifies on Clause 8Med/Surg, it could also qualify
and reimburse on Clause 9 ICU, as that is a non-terminal clause.

Clauses/Terms page with Terminal column outlined in red

Navigate to a clause or term
Access clauses and terms from the Clauses/Terms page.

To navigate to a clause or term:
1. On the Contracts page, expand the desired contract.

2. For the desired contract version, click theDetails link.

3. On the Provisions page for the version, click the desired provision link.

The list of clauses displays in the table on the Clauses/Terms page, as shown in the following
example.

If a clause has any terms, a + button ( ) displays to the left of the clause’s blue square. Click the
button to view the term(s).

Administrator's Guide Axiom Contract Management │ 62



4. To return to previous pages, click the Return to [page] link in themenu on the left.

About multiple-procedure payment reduction line items
When you build contracts that includemultiple procedure payment reduction (MPR) line items, if those
line items have four or more reimbursement rates, you can model them using MPR calculations by
percentage. The Line Item CodeMPR calculation handles both dollar and percentage rates, whereas the
Line Item ASC handles only dollar amounts. The Line Item CodeMPR calc basis calculates claims that are
reimbursed based on multiple-rate tiers. This calc basis is available in the Calc Basis menu for clauses and
terms, as shown in the following example:

Line Item MPR uses Translation Tables similar to Line Item ASC. Translation Tables consist of columns of
line item codes and their associated Group column. (You don’t need to add descriptions to the table
because they are automatically populated based on the existing Line Item Code library entries.)
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The Rates form for Line Item MPR has a ten-tier procedure reduction calculation consisting of nine rate
columns and one sub rate column on the Category Assignment tab to handle procedure reduction logic
in contracts. You do not need to specify all ten tiers, but at minimum you must specify one rate and the
Subrate column. You can enter rates manually or upload translation and rates tables. For more
information, see Import rates for a clause or term.

With Line Item MPR, rates may be either percentages (loaded as decimals) or dollars.

When loading rates using an Excel file, the Subratemust be defined. The Subrate is the last payable rate.
For example, if a contract says all services are reimbursed at 100/50/25/25, then program 100% of the
given rate in Rate 1, 50% of the given rate in Rate 2, and 25% of the given rate in the Subrate. This causes
all services found in the Translation Table to be calculated.

If reimbursement is limited to a set number of services, use the rate columns and Subrate to limit
reimbursement. For example, if only three services are payable, program Rate 1 - 3 with the appropriate
value and Subrate with $0. This prevents any services from calculating after the third procedure.

As with Line Item ASC, reimbursement order is determined by rate, assessing the services with the
highest reimbursable amount and paying those first.
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When a qualifying claim comes in and triggers on the Line Item MPR clause, the system determines the
group it belongs to based on the Translation Table. After all qualifying line items are grouped, the system
assigns the rates to each group based on the Day of Service and rates set for the clause/term.

For more information, see the following:

l About clauses and terms
l Add a clause to a provision
l Add a term to a clause

� Claim voucher reports display Line Item Code MPR calc details
When reconciling an MPR calculation on a claim, you can use the voucher report to see which line items
on the claim triggered Line Item CodeMPR on a contract and were paid based on that calculation logic.
You can use this detail to track down under or over payments and to justify proper payment from the
payer.

In the following example, a claim voucher report displays the following details for a Line Item MPR
calculation on a claim:

l The service codes on the claim that matched those on the Line Item MPR clause
l The service date detail, line item code with description, and the group, units, and qualified level
l Payment amount for each
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About volume discount calculation line items
Users modeling contracts can includemulti-channel discount calculations to handle volume discount
pricing on claim line items. The Line Item CodeMulti-Channel Discount calculation basis calculates claims
against contract line items that are reimbursed based on volume tiers. This calculation basis is available
in the Calc Basis menu for clauses and terms, as shown in the following example:

This calc basis pays a set amount based on the number of units found for a set of procedures on a claim.

Multi-Channel Discount line items use Translation Tables similar to the way Line Item ASC does.
Translation data consists of a column of line item codes and a Category column. The description does not
need to be in the Translation Table because it automatically populates with the description in the Line
Item Code Library.
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The Rates form for this type of line item contains multiple lines for specifying categories, number of units,
rates, and the effective range of those rates based on unit volume. You can enter rates manually or
upload translation and rates tables. For more information, see Import rates for a clause or term.

For each category, claims are paid based on a volume discount of tiered pricing. In the following example,
all items are for Category 1. If an incoming claim fits Category 1 and has two units, the rate paid is $6.00
because the Effective Range is 2 <= Units < 4. If the claim has four units, the rate paid is $7.00 because the
Effective Range is 4 <= Units < 6. Any claim with six units or more is paid at the $15.00 rate.
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For more information, see the following:

l About clauses and terms
l Add a clause to a provision
l Add a term to a clause

� Claim voucher reports display Volume Discount calc details
When reconciling a multi-channel discount payment calculation on a claim, you can use the voucher
report to see which line items on the claim triggered a Line-Item CodeMulti-Channel Discount calculation
on the claim, and were paid based on that calculation logic. You can use this detail to track down under
or over payments, and to justify proper payment from the payer.

In the following example, a claim voucher report displays the following details for a multi-channel
discount calculation on a claim:

l The Line item Multi-Channel Discount codes on the claim that matched those on the clause
l The service date detail and the category
l Payment amount for each
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Add a clause to a provision
When creating a clause, you need to select the calculation criteria. For information on Calc Basis, Calc
Type, Calc Measures, and Terminal vs. Non-terminal, see Using clauses and terms.

You can also add attributes to a clause.

To add a new clause:
1. Navigate to the desired contract version and click theDetails link.

2. Under the Provision title, click the link.

3. In themenu on the left, click New Clause.

4. On the new clause row, in theDescription field, select the description from the drop-down.

NOTE: If needed, you can add a new description.

5. From the Calc Basis drop-down, select the basis for calculation.

6. If applicable, from the Calc Type drop-down, select the calculation type.

7. If applicable, from the Calc Measure drop-down, select themeasure on which the calculation is
made (for example, Per Claim, Per Line Item, Per Diem).

8. From the Terminal? drop-down, select Yes for Terminal orNo for non-terminal.

9. Click Save.

10. In the Rates field, do one of the following:
l For a single rate, type the rate into the field.
l For multiple rates, enter rates manually or import rates from a file.

11. Click Save.
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Clauses/Terms page showing new clause added at bottom of page

Add a term to a clause
A term always resides beneath a clause. The clause is considered the parent of the term.

When creating terms, you need to select the calculation criteria. For information on Calc Basis, Calc Type,
Calc Measures, and Terminal vs. Non-terminal, see Using clauses and terms.

To add a new term:
1. Navigate to the desired clause or term.

2. For the desired clause, click the blue square at the beginning of the row. (A black arrow displays in
the blue square when selected).

3. Click New Term. The term row automatically displays below the selected clause.

4. In the new term row, from theDescription drop-down, select the description of the service or
procedure.

NOTE: If needed, you can add a new description.

5. From the Calc Basis drop-down, select the basis for calculation.

6. If applicable, from the Calc Type drop-down, select the calculation type.

7. If applicable, from the Calc Measure drop-down, select themeasure on which the calculation is
made (for example, Per Claim, Per Line Item, Per Diem).

8. From the Terminal? drop-down, select Yes for Terminal orNo for non-terminal.

9. Click Save.

Clauses / Terms page showing new term added at bottom of list.

10. In the Rates field, do one of the following:
l For a single rate, type the rate into the field.
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l For multiple rates, enter rates manually or import rates from a file.

11. Click Save.

Add a clause or term description
The description is the first criterion that you need to define for a clause or term. A few standardized
descriptions are already set in the drop-down list, but you can add a new description if desired.

To add a new description:
1. Navigate to the desired clause or term.

2. In themenu at left, click Descriptions.

3. In the Edit Descriptions window, click Add New.

4. In the new line added to the bottom of the list, enter the description.

5. Click Save.

6. Click Close.

The new description is added to the Description drop-down, in alphabetical order.

Edit or delete a clause or term
IMPORTANT: If you click Save before clicking Return to Provisions, the clause or term is permanently
deleted.

To delete a clause or term:
1. Navigate to the desired clause or term.

2. Click the blue square to the left of the clause/term and then press theDelete key on your
keyboard (there is no Delete button in the application for this).

3. If you accidentally delete a clause or term, do NOT click Save. Instead, click Return to Provisions.

4. To permanently delete the clause or term, click Save.

To change the order of a clause or term:
1. Navigate to the desired clause or term.

2. In the column labeled #, click the clause or term number to activate the sorting arrows, then click
the arrows as needed to select the order number you want the clause or term to sort to.
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New order number selected for PSYCH

PSYCH appears in new place after saving

3. Click Save. The contract refreshes to the new order.

At this point, the order is manually controlled. Be sure that all clause numbers are unique, as are the
terms beneath them.

Edit or delete a clause or term description
IMPORTANT: If you change a description, the change will be reflected in all accounts and data where
the description is used.

To edit a clause or term description:
1. Navigate to the desired clause or term.

2. In themenu at left, click Descriptions.

3. Select the desired description and then make your changes.

4. Click Save. A green confirmation message appears briefly.

5. Click Close.

To delete a clause or term description:
1. Navigate to the desired clause or term.

2. In themenu at left, click Descriptions.

3. Select the desired description.
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4. Press theDelete key on your keyboard.

5. Click Save, then click Close.

Manually add rates to a clause or term
Use these instructions when you need to add a few rates. For one or more pages of rates, import the
rates from a file instead of adding them manually.

To manually add rates to a clause/term:
1. Navigate to the desired clause or term.

2. In the Rates column, click the View or Set button (if rates are currently applied, the button
displays as “View”).

3. In the Rates window, click Add Row. A new row displays in the Rates Data View tab on the left, as
shown in the following example.

4. In the Code field, type the code associated with the chosen calc basis for the clause/term, and
then in the Rate field, type a corresponding rate. You have the option to add a grouping
description for larger based rate schedules if needed.

5. (Optional) To apply the same rate to all the entered codes:
a. Click the small check box to the left of the code.

b. In the Edit section on the right side of the form, enter the amount in the text box to the
right of the Rates drop-down.
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c. Leave the drop-down option at Set rate equal to, and click Apply.

6. To save themanually entered rates, click Save and Exit.

To adjust rates on certain codes, you can select those codes manually with the check mark to the left of
the code, or, for a large selection, using the options under the Row Selection/Selection Scope button
(e.g., select current page if more than one, or select all pages) and then enter a new rate to apply.

Import rates for a clause or term
When working with large fee schedules, manually entering rates may not be feasible. In this situation, it
is better to import the fee schedule or rates table from an Excel workbook. If you are also importing
Translation Tables for a clause/term, you should import those before you import rates.

IMPORTANT: There aremany different types of rate files (DRG, Line Item Code, Rev Code, etc.).
When importing rates, make sure the rate file you upload matches the specific type of calc basis used
by the clause or term. For example, for a DRG rate file that has a dollar rate in it and not a percent %,
it should use: Calc Basis = DRG; Calc Type = Dolar Rate; Calc Measure = Per Claim, on the clause or
term to which you attach it.

When importing rates, you first upload the rate file to the server, then you attach it to the contract.

To import the rates:
1. In the Rates column of the clause/term, click Set (or View, if there are existing rates and you are

replacing/modifying them).

2. In the Rates window, click the Rates Import Files tab.

3. On the right of the window, click Upload/Specify Files.

4. In theUpload/Specify Files dialog, on the folder view side, the Rates folder should be highlighted
blue. This is your target folder. On the right side of the dialog, click Choose File and browse to the
location of the desired rates file/fee schedule, and then click the file and click Open.
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5. When the name of the file displays in the Choose File field, click Upload.

The uploaded file is placed on the server under the defined Calc Basis folder.

6. On the folder view side of the dialog, click the uploaded file to select it. On the right side. Click
Specify.

The Upload/Specify Files form opens, displaying the columns in the Excel file.

7. On the lower left of the form, in the Excel Column, for each row in the Rates Column, select the
letter that corresponds to column in the image of the Excel file above it. In the following example,
ASC corresponds to column A in the ACS Rates file. Do this for each field in the Rates Column that
needs to bemapped.
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8. Select whether or not the file uses headers, and then click Save Specifications.

9. Close the form.

After a file is specified, a red check mark displays to the left of the file in the Upload/Specify form.

10. Attach the file: click Attach .
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11. Close the Rates window.

Import translation tables
Translation tables are crosswalk code tables that map equivalent, identical, or similar information across
two or more distinct data sets. Most crosswalking is done between a newer version and an older, out-of-
date version of the same code set. Certain Contract Management Calc Bases, such as the following, all
require translation tables:

l Line Item Code Incidental
l RevCode Incidental
l Line Item CodeMPR
l Line Item Code ASC
l Multi-Channel Discount

Importing translation tables follows the same basic process as importing rate files.

To import a Translation Table:
1. Navigate to the clause or term.

2. In the Rates column, click Set (or View if you are replacing an existing translation table).

3. In the Rates window, click the [Calc Basis] Import Files tab.

4. On the right side of the window, click Upload/Specify Files.

5. In theUpload/Specify Files dialog, on the right, click Choose File, then browse for and select the
desired Translation Table file, and then click Open.

6. When the name of the file displays in the Choose File field, click Upload.

7. On the folder view side of the dialog, click the uploaded translation table file to select it, and then
on the right, click Specify.

8. In theUpload/Specify Files form, on the lower left, in the Excel Column, for each row in the Rates
Column, select the letter that should correspond to the column in the image of the Excel file above
it.
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9. Select whether or not the file uses headers, and then click Save Specifications. Close the form.

10. In the Specified Translation Files box, click Attach.

11. If desired, click the Translation Data View tab to view the uploaded information.

12. Close the Rates window.

Attach or re-attach a file
Sometimes there aremultiple files available to attach, if for example, there aremultiple Rev Code calc-
based clauses.

If you accidentally attach the wrong schedule, do the following:

1. Click the Rates Import Files tab.

2. Click Upload/Specify Files and select the correct file to attach. This removes any rates previously
attached and brings in only the rates from the selected file.
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NOTE: To add additional rates, there are two options: 1) Upload, specify and attach a new file that
includes all rates required for the clause, or 2)manually add the new codes and rates.

IMPORTANT: Be aware that if a rate file is re-attached, any rate codes added manually will be
removed, replaced by what is in the file.

Delete an uploaded file
Use these instructions to delete files from the server that were attached to clauses or terms, but are no
longer in use. Such files include rates, fee schedules, translation tables, thresholds, Rev codes, etc.

To delete an uploaded file:
1. Navigate to the clause or term and then in the Rates column, click the View button.

2. In the Rates window, click the [Name] Import Files tab and verify that the file to be deleted is not
in use. If the file is in use and you want to delete it, you can do so without removing the
information from the clause or term as long as the imported file was the last one attached.

IMPORTANT: Although information imported from files is retained when you delete the
imported file, if you import another file and attach it to the clause or term, the previous
information is replaced with the new information.

Files in use have highlighted rows and checked boxes at the beginning of their rows.
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3. On the right, click theUpload/Specify Files button.

4. In theUpload/Specify Files dialog, on the left side in the folder view, locate and click the file to
select it.

5. On your keyboard, press theDelete key.

6. In the confirmation dialog, click OK. The file is removed from the system.

View rates for a clause or term
A clause or term may have a single rate, multiple pages of rates, or a set of tiered rates, depending on the
service or procedure, or group or combination of services/procedures, contract type, provision, and so
on. If a clause or term has a single rate, the rate displays in the Rates column. If a clause or term has
multiple rates or a set of tired rates, the Rates column displays a View button that opens the rates in the
Rates window. The Rates window also displays associated information and any attached files, if
applicable.
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Example of Rates window for a clause with multiple procedures and rates

To view the rates associated with a clause or term:
1. Navigate to the desired clause or term.

2. On the Clauses/Terms page, look in the Rates column for the clause/term.

l If the clause/term has a single rate, it is displayed in the cell in the Rates column.
l If the clause/term has multiple or tired rates, the column displays a View button (if the

rates have not be set, the button reads “Set”). Click the button.

Set up post-grouper custom pricing
Some StateMedicaid and commercial Medicare-like plans useMedicare grouping methodologies but
then override some of the reimbursement rules for certain status indicators or APC codes. Or, they
simply pay at a percentage aboveMedicare. To model these adjustments to Medicare reimbursement,
you need to be able to model these kinds of adjustments.

NOTE: These instructions do not apply to actualMedicare contracts, only Medicare-like contracts
from commercial plans.

When modeling contracts for commercial Medicare-like plans that use customized Medicare grouping
methodologies, you can include adjustments to the CMS Outpatient calculation. For example, you can
set rates for clauses and terms that use the CMS Outpatient calc basis, and adjust those rates as needed.

During the CMS Outpatient calculation, the system receives the results from the 3M grouping and pricing
process and pulls the results into the voucher. You can adjust the voucher results as necessary for
payment in the following ways:

l Adjust the CMS Outpatient calc basis in the Rates window:
o No Adjustment – No adjustment is made to the rates coming from the grouping and

pricing process. This is the default selection.
o Overall Percentage – Adjust the post-grouping and pricing rate by a specified percentage.
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o APC Status Indicator – Adjust the calc basis based on the SI.
o APC code adjustment – Adjust the calc basis based on the APC code.
o Line-item code adjustment – Adjust the calc basis based on the line-item code.

Adjust rates for a CMS Outpatient calculation

Use these instructions to modify rates for a CMS Outpatient calc basis on a clause or term, as part of
modeling post grouper custom pricing.

To set up post-grouper custom pricing on a contract:
1. Navigate to the desired clause or term for a provision with a clause or term with a CMS Outpatient

calc basis.

2. In the Rates column, click Set.

3. In the Rates window, in the CMS Outpatient Adjustments View tab, select the type of
adjustment:

l No Adjustment – No adjustment is made to the rates coming from the grouping and
pricing process. This is the default selection.

l Overall Percentage – Adjust the post-grouping and pricing rate by a specified percentage.
l APC Status indicator – Adjust the calc basis percentage based on the Status Indicator.
l APC – Adjust the calc basis percentage based on the APC groupings.
l Line Item Code – Adjust the calc basis percentage by specific line items on a claim.

4. Do one of the following, depending on your selection in the previous step:
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l If you selected Overall Percentage, then in the Adjustment field, enter a percentage
written as a decimal value (e.g., 0.07), and then click Save. Skip to step 13.

l If you selected APC Status Indicator, APC, or Line Item Code, proceed to step 5.

5. Click the CMS Outpatient Import Files tab.

6. In the Specified Files box, on the left of the header, from the drop-down, select the type of
adjustment you selected in step 3, and then click Upload/Specify Files:

7. In theUpload/Specify Files dialog, click Choose File, and then select the file that fits the
adjustment type you selected. In the following example, a file with SI adjustments is selected.
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8. In the pane on the left, click the destination folder for the file, then in the Select a File to Upload
pane, click Upload.

After the file uploads, you should be able to see your file located in the destination folder:

9. Select the file on the left, and then on the right, in the Specify a file for Import section, click
Specify.

10. If the file needs to be formatted before importing, you are prompted to make the selections in the
dialog. Use the following example as a guide. When finished, click Save Specifications, and then
close the dialog.
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11. In the Specified Files section, click Attach.

12. Click the CMS Outpatient Adjustments View tab. The rates from the uploaded file display:
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13. Close the Rates window. The Rates column on the clause/term now reads “View.”

Using thresholds
A threshold is a specific type of calculation that can be placed on either a clause or a term within a
contract. Thresholds are used in situations where unique reimbursement is based on defined parameters
by the payer.

To define the threshold’s parameters, a Thresh Basis must be determined. A Thresh Basis is used in
conjunction with both a Lower Bound and an Upper Bound to make a claim qualify for the clause/term. A
Thresh Basis can be either claim-based (Total Claim Days or Total Claim Charges), or line item-based (Total
Line Charges/Units or Total Daily Line Charges/Units).

The Calc Basis, Calc Measure, and Calc Type, selected based on standard contract building rules, define
how the claim pays on the clause or term if the Thresh Basis Lower Bound and Upper Bound criteria are
met. As in normal contract building rules, the Calc Basis is used to determine if a claim qualifies for the
clause or term. The Calc Measure and Calc Type combined define how the claim is paid.

The following table provides a list of the possible combinations that can be used with Thresholds. Notice
that the first four are claim level, while the remaining three are line item based. These three calculation
options are used to apply a rate on the claim, but the rate will be held within the limits of the Apply to
Start and Apply to End fields that are set in the Threshold form.
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Calc Basis Calc Measure Calc Type

DRG, CPT4, Rev Code, etc. Dollar Rate Per Diem

DRG, CPT4, Rev Code, etc. Dollar Rate or % Charge Per Claim

Any and All Services Dollar Rate Per Diem

Any and All Services Dollar Rate or % Charge Per Claim

CPT4 or Rev Code Dollar Rate or % Charge Per Date

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item Qty

Add a threshold to a clause or term

When adding a threshold to a clause or term, you select themethod of payment for the clause or term.

Import threshold files
You can add thresholds to a clause or term manually; however, you can add more complicated
thresholds using the attach thresholds option. With this option, you build your threshold requirements
in Excel and upload them to the system instead of entering them manually one at a time. This is the
preferred method for more complex thresholds. See the following section for threshold file
requirements.

� Threshold file requirements
Unlike normal rate files, threshold files require a minimum of the following fields:

l Code – Code used for match (DRG, CPT4, etc.)
l Rate – The rate to reimburse if claim/linematches the threshold conditions (Percentage or Dollar

Rate). Percentages must be represented as decimal values. For example, 100%→1. 99%→ .99
l Thresh Basis – The thresh basis controls which piece of information on the claim/line is analyzed

by the calculation engine to determine if there is a match. Enter the corresponding number below
in the Excel file. For example, if calculating Per Diem, enter 1 for each entry in the file.

o Claim Level Based

o (1) Total Days (Per Diem)

o (2) Total Charges (Per Claim)

o Line Item Based

o (3) Line Charges (Per Line Item),
o (4) Line Units (Per Line Item Qty),
o (5) Total Daily Units (Per Date Units),
o (6) Total Daily Charges (Per Date Charges)
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l Lower Bound / Upper Bound – The lower bound represents the lowest value for your thresh basis
trap. The upper bound represents the highest value for your thresh basis trap. Anything greater
than or equal to the lower bound, and less than or equal to the upper bound, will be considered a
match.

l Apply to Start / Apply to End – In some cases, you may only want to apply a percentage (%) to a
range of your charges, or only apply a per diem on certain days. If this is the case, you would set
your “apply to start” and “apply to end” to the range of days or charges to which you want to
apply your rate.

� Attach or re-attach threshold files
To attach or re-attach threshold files to a clause or term:

1. Navigate to the desired clause/term.

2. In the Threshold column, click the Set button.

3. To import the rates, in the Threshold entry form, click the Threshold Import Files tab.

4. Upload the file to the server: click theUpload/Specify Files button on the right. A new form
opens.

5. In theUpload/Specify Files window, click Choose File and then browse to the fee schedule
location, and click Open.

6. After loading the file location, click Upload to upload it to the Axiom Contract Management server
for specification.

When uploaded, the file is placed on the server under the defined Calc Basis folder and is ready for
specification.

7. Select the file, then click the Specify button to define the columns of your file (refer to the
previous section, Threshold file requirements). A new form opens, displaying the contents of the
workbook, along with the fields needed for the import.

8. Choose the correct Excel column for each field, then select whether or not the file uses headers.

9. Click Save Specifications and close the form.
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After a file has been specified, a red check mark displays to the left of the file in the Upload/Specify
form.

� Use the Duplicate Selected Codes option
When entering thresholds manually, often the information will be the same for every other code. If a
threshold entry exists that can be copied to other codes, you can use the Duplicate Select Codes option.

To use the Duplicate Selected Codes option:
1. Navigate to the desired threshold record and click the View button.

2. In the Threshold Data View tab of the Thresholds window, enter the information for the first
records to duplicatemanually.

3. Select the entry(s) to copy by clicking the check box to the left of the entry.

4. On the right side of the form, click theDuplicate Selected Thresholds check box and then click the
Lookup Codes button.
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5. Find the additional codes that need an entry, select the check box to the left of each code, and
then click Create Threshold Record.

6. Click Save and Exit. The new entry displays.

7. Click Save to save the form.

� Use the Lookup Codes option
To find codes to add as entries to the Threshold Rates form:

1. Without copying the date from a previous code, first verify that the Duplicate Selected Thresholds
box is NOT checked.

2. Click the Lookup Codes button. This opens the same form used in the Duplicate Selected Codes
Option; however, the code will be dropped into the Rates windowwith no other information filled
in but the default values.
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� Threshold examples
The following examples illustrate two situations for using thresholds.

NOTE: Regarding Lower Bounds – The Total Charges or Total Covered Days needs to fall within the
bounds. On the second tier, you may repeat the Low Bound or you may use the given start for the
next tier. The result will be the same as the Apply Start comes into consideration and will only apply
the rate on the excess.

It is important for the first tier to have bounds that capture the full range from 1 to infinite, as that will
ensure the lower tier is also calculated in these examples.

Charges
A payer might state that inpatient services are paid at 50% of charges but any inpatient claim that has
charges in excess of $100k will pay “Tiered Reimbursement” for which there would be varying
reimbursement rates depending upon the charges. In this example, you need to define a couple of key
terms:

l The Thresh Basis is Total Charges because we are paid a different rate based on the charges on the
claim (after we exceed $100k on a claim reimbursement changes)

l Two Rates need to bemodeled. As an example:
o 50% for the all claims up to $100k
o 75% on all claims exceeding $100k

l The bounds capture the Total Charges from the claim. For the 50%Rate, the Lower Bound would
be $1 and the Upper Bound would be infinite ($99,999,999). The next fields control the application
of the rate. The Apply to Start would be $1 and the Apply to End would be $99,999k because we
want the 50% to apply to all charges up to $100k.

l For the 75%Rate, the Lower Bound could again be $1 or change to $100k and the Upper Bound
would be $99,999,999. Remember, the Total Charges need to fall within the bounds. However, the
Apply to Start would now be $100k and the Apply to End would be $99,999,999 because wewant
the 75% to apply only to the charges over $100k.

Days
A popular example of Day Thresholds areMaternity Cases. Often Maternity pays a Case Rate for a set
number of days and then adds reimbursement for days in excess.

l The Thresh Basis is Per Diem because we are paid a different rate based on the Covered Days on
the claim

l Two Rates need to bemodeled. As an example:
o The Case Rate for Days 1-3
o The Per Diem Rate for Days greater than 3
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l The bounds capture the Total Covered Days from the claim. For the Case Rate, the Lower Bound
would be 1 and the Upper Bound would be infinite (999). The next fields control the application of
the rate. The Apply to Start would be 1 and the Apply to End would be 1, because wewant the
Case Rate to only calculate once. So wewill have it calculate on the first day (eliminate claim
variability).

l For the Per Diem Rate, the Lower Bound could again be 1 or it could be 4 and the Upper Bound
999. Remember, the Total Covered Days need to fall within the bounds, but the Apply columns
control applying the rate. So the Apply to Start would be 4 and the Apply to End would be 999
because wewant the Per Diem Rate to apply only to days exceeding the defined parameters of the
case rate.

Using limits
Axiom Contract Management gives you the ability to model “lesser of” and/or “greater of” language
common among many payers. These are known as limits because they limit reimbursement for a
particular case, and can be added to any clause, term, or provision, in a contract. Limits are built just like
clauses and terms, except that they sit on top of clauses and terms. In other words, they belong to the
particular clause or term they reside on; or, in the case of global limits, the provision that they reside on.

� Limit restrictions
In Axiom Contract Management, you do not need to worry that your limit may not be compatible with
the parent clause or term that you are adding it to, because the system handles it automatically. The
type of limit you can set on a particular clause or term depends on its parent type. For example, if you
are creating a limit on a case rate type clause, the type of limits available when you build it are restricted
to case rate calculation bases and types. Conversely, if you are creating a limit on a line item clause or
term, Axiom Contract Management restricts your limit selections to line item calculation bases and
types. This is an added benefit to contract modelers who sometimes get confused about what kind of
limit is allowed on particular clauses or terms.

� What is a Maximum?
AMaximum sets a limitation on the particular clause or term it sits on, restricting it to a specified amount
that it can receive ATMOST. For example, if you would like to limit reimbursement to the lesser of 100%
of charges on a DRG Case rate clause, you would set a max on that clause paying 100% of Any/All
Services. When the calculation attempts to calculate the claim, it will create a record for the DRG Case
rate, a record for theMaximum, and then compare the two and pay whichever is less.

� What is a Minimum?
Aminimum sets a limitation on the particular clause or term it sits on, restricting it to a specified amount
that it must receive at a bareminimum. For example, if you have a percent of charge clause that pays
50% of charges but your contract states that you will receive at least $500 for every claim, then you would
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create a minimum on your % of charge clause, setting it to pay $500 of Any/All Services per claim.

� Limit hierarchies
In many cases, you will be creating contracts for which you have terms attached to clauses, and would
like to limit both the clause and its attached terms. Axiom Contract Management allows you to do this by
setting limits on both terms and their corresponding parent clause; however, there is a hierarchy
involved when doing so.

After all applicable terms are calculated, the clause limit is applied as a final step to determine if the limit
(s) apply or not. Remember, terms report their reimbursement back to their parent clause, so if a limit
exists on the clause, all terms attached to it are subject to that limit.

There are cases in which you will not want to include a particular terms reimbursement when applying
the limit. Axiom Contract Management allows for this by enabling you to toggle a term’s Include option.
When you set a limit on a term, a check box becomes enabled on the term, allowing you to include its
reimbursement or to exclude its reimbursement from reporting back to the parent clauses limit. In Axiom
Contract Management, these are known as “Carve-out” terms. Their reimbursement does not count
toward the parent clause limit and are added to the result after the limit winner is determined. The
Include option can be located on terms for normal limits, and clauses for global limits.

Create a limit

You can create limits on three different levels:

l Clauses
l Terms
l Provisions

NOTE: Limits on provisions are global limits. Global limits apply to all clauses and terms under a
provision.

To create a limit:
1. Navigate to the desired clause or term.

2. Do one of the following:
l Add a line item limit.
l Add a maximum or minimum limit.
l Add a global limit.

After attaching your limit, the Set button changes to read “View.” Limits are defined generally as
Maximums and Minimums, and either cap or raise reimbursement.
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Create a maximum or minimum limit

Adding a minimum or maximum limit to a clause or term restricts the reimbursement to a specified
amount that it can receive at most or at least.

To create a new maximum or minimum:
1. Navigate to the desired clause or term.

2. In the Limits column, click Set (or View, if you are editing an existing limit).

3. In the Limits window, click Add New. A new row is added to the form.

NOTE: Although you can add several maximums and minimums on the same clause or term,
we recommend that you create, at most, onemaximum and oneminimum per clause, term,
or provision.

4. Creating a minimum or maximum works in the sameway as creating a regular clause or term:

a. In theDescription field, select a description from the drop-down.

b. In the Calc Basis field, select a calc basis from the drop-down.

c. Depending on which calc basis you selected, you may or may not need to select a Calc
Type, Calc Measure, and then enter the corresponding rate(s) and/or set Exclusions.

5. Click Save. See the following example:

Create a global limit

Global limits allow you to createmaximums and minimums on a Global (provision) level. If you want to
model a limit that applies to all clauses in your provision but do not want to create it separately on each
clause, a Global limit is the best solution, allowing you to create a single limit and apply it to all, or just a
specific set, of clauses.
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To create a global limit:
1. Navigate to the desire clause or term.

2. In theGlobal column, click the Set button.

3. Add themaximum or minimum as needed.

4. Click Save, and close the global limit window.

Create a line-item limit

When a limit is defined on a line-item clause or term, it no longer compares the final reimbursement for
that clause or term to the limit, but instead compares the reimbursement to the limit on a line-by-line
basis. Themost common way to use the line-item limit is by capping fee schedules at the charge amount.
The capping of fee schedules is language common to several managed care contracts, which typically
would state that all fees are paid the lesser of charges or the pre-determined fee scheduled amount.

To create a line item limit for a clause or term:
1. Create the clause or term or navigate to an existing clause or term.

2.  From the Calc Basis drop-down, select Line Item Code.
a. From the Calc Type drop-down, select Dollar Rate.

b. From the Calc Measure drop-down, select Per Line Item.

3. Attach your fee schedule to the clause/term. See Import rates for a clause or term for detailed
instructions on attaching fee schedules.

4. On the clause/term, in the Limits column, click the Set button.
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5. In the Limits window, in theMaximum section, click Add New.

6. In theDescription column, select a description for the Limit.

7. To define the limit to create the cap, do one of the following:
l Load the fee schedule again with a rate of 100%, and then do the following:

a. From the Calc Basis drop-down, select Line Item Code.
b. From the Calc Type drop-down, select% Charges.
c. From the Calc Measure drop-down, select Per Line Item.

l Use the Any Matching Line Item option. This option is easier in this case because a
separate rate file is not required:

a. From the Calc Basis drop-down, select Any Matching Line Item.
b. From the Calc Type drop-down, select% Charges.
c. From the Calc Measure drop-down, select Per Line Item.
d. In the Rates column, enter 100%.
e. Click Save.

The option Any Matching Line Item basically sets a limit for any line item that calculated on
the parent clause/term, and is a handy way of quickly building a line-item limit.

Add a unit max limit to an MPR calculation

Use these instructions for adding a Unit Max limit on a contract clause or term that uses the Line Item
MPR calc basis. Setting a unit max limits howmany units are paid. The unit max acts as a counter; when
the limit is reached, additional claims for that item are paid at $0.

NOTE: The Unit Max limit used on an MPR calculation applies to professional claims only.

To add a unit max limit to an MPR calc method on a clause or term:
1. Navigate to the Clause/Terms page for the contract’s desired provision.

2. In the navigation menu on the left, click New Clause (orNew Term, if you are adding a term).

3. In the new line that displays, from theDescription drop-down, select a description.

4. From the Calc Basis drop-down, select Line Item Code MPR.

5. From the Calc Type drop-down, select Dollar Rate.

6. From the Calc Measure drop-down, select Per Line Item.

7. In the Rates column, click Set and add the rates.

8. Click Save.

9. In the Limit column of the new row, click Set. The Limits window opens.

10. Click Save.
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11. In theMaximum section, click Add New.

12. From theDescription drop-down, select the description.

13. From the Calc Basis drop-down, select Unit Max.

14. In the Rates column, enter the unit limit. For example, if the unit is the number of therapy
sessions, and the contract stops paying after the 6th visit, enter 6.

15. Click Save.

Notice that the Limit column for the clause now reads “Max,” as in the following example.
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The voucher report for claims that are run against this limit display the limits and a payment of 0
once the rate cap is met.

Move, copy, or delete contract files
If there are schedules you can use from other contract version(s), in the Upload/Specify form, you can
either move a file or make a copy from another folder location by dragging and dropping.

To move, copy, or delete a file:
1. In theDrag/Drop Action section of theUpload/Specify Files form, do one of the following:

l SelectMove to move the file from the folder it is being dragged from to the new folder. This
will completely remove the file from that folder.

l Select Copy to place a copy of the file in the location it is dragged to.

2. Select the contract version and rates file to use in the current contract, and drag it to the desired
folder.

NOTE: If the rate file you want to copy is not in view, then at the top of the Files list on the
left, click the Show all folders option.

In the following example, the fileWMC BCBS APDRG 2014.xls is copied from one version to
another. The user clicks the Copy button and drags the file to the current contract location.

3. To remove a file from a contract rates folder, select the file, then press theDelete key.

4. In the confirmation dialog, click OK to delete the file, or click Cancel to keep the file.
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Attach a file to a contract
When modeling contracts, you may need to attach documents to support the contract. You attach files
to contracts at the version level. You can attach files such as images, .pdfs, Excel worksheets, or any
other document supporting the contract. Users can download, open and view the documents as long as
they have access rights to do so. Only system administrators can delete documents from contract
versions.

NOTE: To view attached files, users must have an application that can read the file type installed on
their machines. Keep this in mind when attaching files.

To attach a file to a contract:
1. Navigate to the desired contract and then expand it to view the versions.

2. For the desired version, in the Attached Docs column, click the attach document icon ( ).

3. In the Attached Documents window, in the View/Attach tab, click Choose File, and then browse
for and select the document.

4. Click Attach. The document file displays in the List of Attached Documents for Version # section of
the window.]

5. Close the Attached Documents window by clicking the X icon in the upper right corner.

Notice that the attached docs icon in the Attached Docs column has changed to a document icon (
).

You can also copy and attach documents that are attached to other contract versions.

Copy an attached file to another contract
You can copy a file attached to one version of a contract to another contract.
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When attached, users can download, open and view the documents as long as they have access rights to
do so. Only system administrators can delete physical contracts from contract versions.

NOTE: To view attached files, users must have an application that can read the file type installed on
their machines. Keep this in mind when attaching files.

To copy an attached file from one version to another:
1. Navigate to the version you want to attach the document to.

2. For the desired version, in the Attached Docs column, click the attach document icon ( ).

3. In the Attached Docs column, click the document icon ( ).

4. In the Attached Documents window, click the Copy tab.

5. In the List of Attached Documents for Version [#] section of the Attached Documents window,
select the document to copy.

6. Click the Copy tab.

7. If needed, select the Simulation.

8. In the Contract field, select the contract from which you want to copy an attached document.

9. In the tree-view of versions, click the document to copy, then click the Attach button.

10. Close the window.

The icon in the Attached Docs column is now a document icon ( ).

View a file attached to a contract
When calculations are off, or there is a discrepancy in the contract data, it may be helpful to view the
physical contract to compare it against themodeled one. If the physical contract is attached to the
modeled contract, you can do this.

If you have permissions to do so, you can view files attached to contract versions.

To view an attached contract file:
1. On the Contracts page, navigate to the contract version with the attached document.

2. In the Attached Docs column, click the document icon ( ).

3. In the List of Attached Documents for Version [#] section of the Attached Documents window,
select the document to view.

4. At the bottom left of the window, click View.

5. The document downloads to your computer. The file is visible in the bottom left corner of the
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page.

6. Click the document file name to open and view the document.

NOTE: If you do not have the application required for viewing the document installed on your
computer, you will not be able to open and view the file.

Copying contracts
After a set of contracts is built into Axiom Contract Management, you can use existing contracts as the
basis for new contracts. You have three options for copying contracts or provisions: copy a version,
export/import a provision, and convert a provision. You can also copy an entire contract from one
simulation to another.

IMPORTANT: If any provisions exist on the version you want to copy into, do NOT use the Copy
Version method because it will remove all existing provisions before it copies over the new item(s).
Use the Import Provision feature instead.

Copy a version
Before you copy a version, theremust be a destination to copy it to.

To copy a version:
1. In themain menu header, click Contracts > View Contracts.

Only copy into an empty version (emptymeans it has no provisions).

IMPORTANT: If any provisions exist on the version you want to copy into, do NOT use the
Copy Version method because it will remove all existing provisions before it copies over the
new item(s). Use the Import Provision feature instead.

2. For the contract you want to add a copied version to, create a new, empty contract version:
a. Select the contract by clicking the blue square to the left of the contract name.

b. In themenu on the left, click New Version.

A new row is added to the list of versions.

c. Click the blue square to the left of the new version row.

3. Hold down the Ctrl key and click the blue square to the left of the version to copy from. The Copy
Version button should now be active in themenu on the left.

NOTE: You do not have to copy from within the same contract.
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4. Click Copy Version.

5. In the Copy Versions window, verify that the From/To order is correct. If it is not correct, click the
Swap From/To button on the lower left of the window.

Copy Versions window with From/To boxed in red

6. If you are importing a provision to a new version, ensure that any dates in red from the copied
provision are updated to the new version's date range.

NOTE: The dates will not reset if you do not change them to fit the target version.
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7. (Optional) To copy any attached documents, click the Copy Attached Documents check box.

8. (Optional) To copy any attributes, click the Copy Attributes check box.

9. (Optional) To copy insurance plan codes, click the Copy Insurance Plan Codes check box.

10. Click Copy.

Export and import a version
IMPORTANT: Export/Import Provisions is not a preferred tool to copy contracts into Live. It should
be done as a time-saving safety net in case a contract is irreversibly altered incorrectly.

We recommend that you maintain your own contract backups in case of an irreversible error. You can
create backups using the Export Version feature.

To export a version:
1. On the Contracts page, navigate to the desired contract version and select it.

2. Click the Export Version button, as shown in the following example.

3. In the Export Contract Versionwindow, type a name for the exported version and then click
Export.

When the process is complete, the system displays a confirmation window:
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To import that version back into a contract:
1. Select the contract to receive the version.

2. In themenu on the left, click Import Version.

3. In the Import Contract Versionwindow, select the version to import from the list of previously
exported versions, and click Import.

When the green message displays on the window, as in the previous example, the process is
complete.

4. Click Close.

Convert a provision
If an existing contract is similar to the one you are working on and only slight modifications are needed,
you can convert a provision instead of re-building it from scratch.

To copy a provision within a version:
1. Navigate to the desired contract and expand it to view the versions.

2. For the desired version, click theDetails link.

3. On the Provisions page, click in the blue column for the desired provision to select it.

4. In themenu on the left, click Convert.

5. In the Provisions Settings window, select the Type of Bill the new provision represents, along with
the desired date range.

6. To save as a new provision, at the bottom-left of the window, click the Save as new Provision
check box.
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7. Click Convert Provision.

8. Click Save.

Import a provision
If a contract already has a provision, you can import additional provisions. Importing additional
provisions rather than using the Copy function preserves the existing provisions instead of overwriting
them.

If you are creating a new contract and an existing provision in another contract resembles the provision
you are building, you can import it as a copy.

NOTE: The Import Provisions feature allows you to bring in provisions from any contract
environment.

To import a provision:
1. Navigate to the desired contract.

2. For the desired version, click theDetails link.

3. On the Provisions page, in themenu on the left, click Import.

4. In the Import Provisionwindow, select the Simulation containing the provision. You can import
from any environment, Live or Simulation.

5. In the Payer Name section, expand the desired contract, then expand the desired version to view
the provisions.
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6. If any of the dates are red for the provision you want to import, click in the Start Date and Exp.
Date fields and select dates that match the Start and Exp. dates of the version to which you are
importing the provisions. When updated successfully, the dates turn black and the provision
check boxes are enabled.

7. Click the check boxes for the desired provisions, and then click Import.

8. In the Provision Importedmessage dialog, click OK.

Copy an entire contract to a simulation
Use the following instructions to copy a contract to a new or existing simulation. To copy only a portion
of it, use the Import Provisions feature, which allows you to bring in provisions from any contract
environment.

To copy a contract:
1. At the top of the Contracts page, click the Edit Simulations link.

2. In the Edit Simulations window, expand the desired simulation by clicking the plus symbol (+) to
the left of the name.

3. Click the name of a contract and drag it to the desired simulation.

NOTE: This does not move the contract, this creates a copy in the new location.

4. Click Save.

5. To close the Edit Simulation window, click the X in the upper right corner.

You can now edit the contract with new proposed rates.
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Managing simulations
The ability to run a nearly endless number of simulations is one way that Axiom Contract Management
sets itself apart from older editions. Simulations are an essential tool during contract negotiations,
allowing you to model a number of proposed contracts and run reports for comparison to determine
which proposal is most profitable.

Create a simulation environment
Using the same contract structure between simulations allows you to get a more accurate view of how
facility reimbursement is changing, and which services are affected.

When there are contracts/versions/provisions/clauses built in the simulation environment, the Edit
Simulations window displays these pieces as shown in the following example. Some pieces of information
are editable in this window, such as the dates, but the names are read-only. Again, this is where you can
copy contracts between your Live and Simulation databases.

5
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Example simulation contract

To create a simulation environment:
1. At the top of the Contracts page, click the Edit Simulations link.

The Edit Simulations window opens.

2. To create a new environment, click the Add New button on the left.
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3. Below the list of environments is a text box with “NewSimulation” in it. Rename the simulation and
click Save. The newly created environment can now hold contracts.

You can add contracts by creating them from scratch or by copying contracts from other simulations,
including Live.

Edit or delete a simulation environment
You can edit simulations as needed, especially after copying a contract to the simulation.

You can do the following in the Edit Simulation window:

l Change a simulation name
l Change contract names, version names, provision names
l Change start dates and end dates for versions and provisions
l Delete contracts, versions, and provisions
l Delete a simulation

To edit or delete a simulation:
1. At the top of the Contracts page, click the Edit Simulations link.

2. In the Edit Simulationwindow, for the desired simulation, do any of the following:
l To change the simulation name, a contract, version, or provision, click the name to

highlight it. In the Simulation Name field at the bottom of the window, edit the name.
l To change the Start or End dates for a version or provision, select the version/provision. In
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the drop-down fields displayed for that item at the bottom of the window, select the
desired dates.

l To delete a contract, version, or provision, select the item and click Delete in themenu at
left.

3. To delete a simulation, select the simulation and then click theDelete button.

4. Click Save.

5. Close the Edit Simulationwindow.

Setting up reporting across simulations
Axiom Contract Management administrators can assign simulations to the Expected Payment drill-down
reporting field for side-by-side reporting and analysis. Administrators can map up to four simulations for
a total of fivemapped simulations. The first mapped simulation is to the Live environment, which you
cannot change.

� How the mapping works
The Estimated Payment fields in drill-down reports are used in this case to compare estimated payments
between different simulation environments. These fields are defined with the following field names:

l TotalExpectedPayment1where 1= Live simulation; so TotalExpectedPayment1 equates to
Estimated Payments from Live in drill-down reports

l TotalExpectedPayment2where 2 = a simulation of your choice
l TotalExpectedPayment3where 3 = a simulation of your choice
l TotalExpectedPayment4where 4 = a simulation of your choice
l TotalExpectedPayment5where 5 = a simulation of your choice

When users build drill-down reports, they need to include the TotalExpectedPayment variable for the
desired simulation in a calculated field they add to the report.

In the following example, a contract is compared between two simulations. The calculated fields Exp
Pay1, Exp Pay1%, and Exp Profit1 aremapped to the Live environment by using the variable Total
Expected Payment1 in the equation for each calculated field:

l Exp Pay1 = Sum (Total Expected Payment1)
l Exp Pay1% = Sum (Total Expected Payment1)/Sum (Total Charges)*100
l Exp Profit1 = Sum (Total Expected Payment1)-Sum (Total Cost)

The calculated field Exp Pay2% is mapped to the EPAY2 simulation by using the variable
TotalExpectedPayment2 in the equation: Exp Pay2% = Sum (Total Expected Payment2)/Sum (Total
Charges)*100
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The generated example report looks like the following:

IMPORTANT: Since only administrators can see which simulations aremapped to each mapping
assignment field, as an administrator, you will need to create the custom calculated fields needed
and name them appropriately. For example, a calculated field representing Sum(Total Expected
Payment 1) for a simulation named Aetna KMC could be named AetnaKMC Exp Payment. For
information about creating calculated fields, see “Add calculated fields to a report” in the online help.

� Map simulations to drill-down reporting Expected Payment fields
To map simulations to expected payments variables:

1. In themain menu header, click Admin > Simulation Mapping.

2. For Mapping Assignment 2, click the drop-down arrow and pick a simulation to assign to the
Estimated Payment drill-down reporting field.
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NOTE: Mapping Assignment 1 is set to the Live simulation environment. This cannot be
changed.

3. Repeat for the other mapping assignments as desired.

4. Click Save.

When you make a change to this assignment and click Save, the field is cleared to ensure that all past
calculation results from previously used simulations are not still stored and used in the report.

NOTE: Results from a newly assigned simulation become available only after a user calculates
contracts within the selected simulation. Past calculation results are not retained for a simulation
when it is assigned to a different mapping field.
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Working with claims
The View a Claim function in Axiom Contract Management allows you to access or view all information
related to claims. Themultiple forms of information are compiled from data contained in the Claims,
Payments, and adjustments imports. Other important data fields are calculated by the system, or
imported from other Kaufman Hall systems.

You have the following options for selecting and viewing claims:

l Patient Account Number – Account number or billing identification number imported from the
Claim

l Patient Name – Patient Last Name or any part of Patient Last Name imported from the Claim
l Claim\Number UCRN – Unique record number or Claim Sequence number assigned by Patient

Accounting System

� Live Claims Only option
The Axiom Contract Management system defaults to Show Live Claims Only. To have the system return
results for all instances of the claims, clear the Live Claims check box beforemaking a View a Claim
Selection.

� Access View a Claim
To access View a Claim:
In themain menu header, click Claims > View a Claim.

The View Claims page opens.

6
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Claims page example

View a claim by selected criteria
To select claims by Patient Account Number:

1. From the View Claim Bymenu, select Patient Account Number.

2. In the Enter a Patient Account # field, enter the account number and then click View Claim(s).

To select claims by Patient Name:
1. From the View Claim Bymenu, select Patient Name.

2. In the Enter Patient Name field, type any part of a patient last name, and click View Claims(s). If
this does not work, type in the patient’s first and last names.
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NOTE: If the criteria selected matches multiple claims, all of those claims will appear in the
Account Selection List.

To select claims by Claim/Number UCRN:
1. From the View Claim Bymenu, select Claim #/UCRN.

2. In the Enter a Claim #/UCRN field, enter the number and then click View Claim(s).

� Account Selection List details
If you click on the gray account field Name, the system sorts the list by that column.

The account selection list contains the following claim fields:

l Acct# – Lists the account number imported from the claims.

NOTE: This field is also a link that will bring you into the Claim Details section of View a Claim.

l Claim Type – Identifies the type of claim and its status in Axiom Contract Management
l Organization – Identifies the organization imported from the claim
l Patient Name – First and Last name imported from the claim
l MRN –Medical Record Number imported from the claim
l Admit Date – Admission data imported from the claim
l Discharge Date – Discharge data imported form the claim
l Sub Date – Submission date imported from the claim

l Total Charges – Total Charge amount imported from 0001 line on the claim form minus non-
covered charges
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View claim details
The claim details section of Axiom Contract Management provides an easy-to-use interface that allows
you to view all information associated with a claim. Use the tab-based web pages to navigate from
summary-level information to detailed line item information. To view information on a tab, click the tab
name.

On themenu on the left side of the Claim Detail page are additional options:

l View Voucher – Click this button to open a new browser tab containing the Claim Voucher
Report.

The Claim Voucher Report provides an explanation of exactly how the system arrived at the
expected payment, and howmuch the payer has paid. This information is ideal for follow-up with
the payers to ensure proper payments are being received.

l Go to Contract – Click this button to open the contract in a new browser tab. Additionally, the
specific contract clause will be highlighted, as shown in the following example.
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l Grouper Edits – Click this button to detail all OCE/NCCI and eAPG edits. This is important when
determining why a Medicare or other ACP/eAPG claim has an expected payment = $0. In Axiom
Contract Management, if there is an edit on a line item (code, modifier, etc.), the system
automatically pays the claim at $0. This helps you easily identify claims that can potentially be
fixed and re-billed for a higher total redemption from Medicare. Following is an example of
Grouper Edits for APC ICD9 Code edits.

l Recalculate – Click this button to recalculate the current claim. For more information, see
Recalculate a claim from Claim Detail.

� Claim Detail tabs

� Summary tab
The Summary tab displays information identifying the type of account, the contract used for calculation,
and important demographic information. The Summary tab also contains all the information necessary
to identify whether a claim is paid correctly.

l Expected Payment – Calculated expected payment using contract terms
l Expected Contractual – Total Covered Charges minus Expected Payment
l Actual Payments – Total of all Payments imported by Account # from payment import file
l Actual Contractual – Total of insurance contractual imported by Account # from Contractual File
l Payment Variance – The difference between Expected Payment and Actual Payments
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l Contractual Variance – The difference between Expected Contractual and Actual Contractual
l Total Cost – Sum of Fixed, Variable, and Indirect Cost
l Fixed Cost – Imported from Cost Accounting System – represents fixed cost (materials and labor)
l Variable Cost – Imported from Cost Accounting System – represents variable cost (overtime)
l Indirect Cost – Imported form Cost Accounting System – represent cost not specifically assigned

to dept.
l Actual Profit – Total Covered Charges minus Actual Payments
l Expected Profit – Total Charges minus Expected Payment

� Codes tab
The Codes tab contains all code-related information imported from the claim form. This information
includes:

l ICD9 Codes – Diagnosis and Procedure Codes
l Condition Codes
l Occurrence Codes
l Occurrence Span
l Value Codes
l User Defined Codes

You can navigate through the various code types by clicking the name of that code type. Code type
selection options are shown outlined in red in the following example.

� Demographics tab
Use the Demographics tab to view demographic information imported from the claim.
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� Insurance tab
Use the Insurance tab to view information imported from the claim associated with Primary, Secondary,
and Tertiary payer information.

� Line Items tab
Line Items tab is very important for claim review. Access the tab by clicking the Line Items tab. This tab
displays imported Revenue Code detail for all claims, and Medicare APC information for Medicare OP
claims. The following examples represent a view of a Non-Medicare Claim and aMedicare Claim,
respectively.
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Non-Medicare claim

Medicare claim

Medicare Claims contain two non-Imported Fields with values assigned by the 3M APC GPS software
during import:

l APC – Ambulatory Payment Classification

l Status Indicator (SI) – Identifies type of APC

To see the description of a code listed in the Line Items tab, move your cursor over that tab, as shown in
the following example:

Administrator's Guide Axiom Contract Management │ 121



� Physicians tab
The Physician tab displays physician information imported from the claim.

� Postings tab
The Postings tab details each payment posted to a claim. The system default view is Payments; however,
you can change the view to show the different types of postings individually or together by clicking the
Contractuals or All radio buttons, respectively.

� Tracking tab
The Tracking tab allows you to mark an individual claim for follow-up. This includes identifying:

l The claim’s status
l A generalized assignment category
l The user the claim is assigned to
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l Ten user-defined fields
l Any additional notes

It also allows you to view the claim’s Tracking History to see how it has been managed, and follow it
through the recovery process. A summary of this information is provided on the Summary tab for quick
reference when you open an account.

View Grouper Edits for a claim
When claims are grouped and priced, they may create edits that affect reimbursement. You can view
these edits on a claim and switch to any relevant simulation these claims apply to from the Grouper Edits
window. A Simulation menu at the top of the window allows you to select different simulations to see
any grouper edits that simulation produces for the given contract (the contract needs to bemodeled in
the simulations you select).

To view grouper edits on a claim:
1. From the Claims menu, select View a Claim.

2. Filter for and select the desired claim.

3. In the sidemenu of the Claim Detail page, click Grouper Edits.

4. At the top left of theGrouper Edits window, from the Simulation drop-down, select the desired
simulation.

The report lists any grouper edits that resulted from grouping and pricing the claim in the selected
simulation.
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For more information, see the following:

l View claim details
l Group and price APC and eAPG claims

Using claim tracking
Use Claim Tracking to organize institutional claims that need attention and easily locate them at another
time.

Assign a claim
Assigning a claim is the first step in using the Claim Tracking feature.

To assign a claim:
1. In themain menu header, click Claims > View a Claim.

2. In the View Claim By section on the left, select the criteria for the claims to view, then click View
Claims.

3. In the Acct # column, click the number of the claim to assign.

4. On the claim detail page, click the Tracking tab.

5. Select the following claim details:
l Claim Status – Select Open, Closed, or other user-defined status (Needs Review, Insurance

Pending, etc.).
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l Assignment – Select the general reason for assignment. This is also a user-defined field.

l Assigned To – Select the user assigned to this claim. This is a list of all system users, and is
generated by Kaufman Hall, and cannot be changed.

l User Defined (1 – 10) – Select up to five user-defined fields with numeric formats, and five
with character formats. Administrators can edit them as needed.

l Notes – (Optional) Add any additional information in this text box. For example, provide
details about the generalized assignment reason to offer more specifics to this particular
claim.

6. Click Save. The claim displays in the Tracking History section.

Claim details example

NOTE: System administrators can build new Claim Status options, Assignment options, and User
Defined options into the system from Claim Tracking, as described in Edit user-defined claim tracking
quick filters.

As you follow the claim through the recovery process, you can make additional notes to any of the
critical information on the page. Themost recently saved information displays at the top of the Tracking
History section.

Track assigned claims
Use these instructions for locating claims using the Quick Filters.
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View Tracking tab example

To view/track assigned claims:
1. In themain menu header, click Claims > Track/Assign Claims. The claim tracking page opens.

2. In the View Tracking tab, leave the default filter setting at Use Quick Filters.

3. In the Select quick filters section, select the following claim details:
l Assignment – Select the general reason for assignment, or select Any to return all claims

that match any assignment.
l Assigned To – Select the user assigned to this claim, or select Any to return claims that

match any user. This is a list of all system users, and is generated by Kaufman Hall, and
cannot be changed.

l Status – Select Open, Closed, or other user-defined status (Needs Review, Insurance
Pending, etc.).

l Opened By – Select the user, or select Any. This list cannot be changed.
l Closed By – Select the name of the user or select Any. This list cannot be changed.

NOTE: Only users who set a claim tracking status to “closed” on a claim appear in this
list.

l Denial Category – Select a category or select Any to return claims that match any of the
categories.

l Denial Reason Code – Select a code or select Any to return claims that match any of the
denial reason codes.
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l Service Location – Select a location or select Any to return claims that match any of the
locations.

l Priority – Select the priority or select Any to return claims that match any priority.
l Closed Reason Code – Select a code or select Any to return claims that match any of the

codes.

4. Click View Claim(s). This list of claims matching the set criteria displays below the filter options.

5. To export the list of claims, click Export List. The list is exported to an Excel file that displays in the
lower left corner of the page. Click the file to open it.

6. To view a claim in the list, in the Acct # column, click the linked account number.

Edit user-defined claim tracking quick filters
Some of the claim criteria used in claim tracking Quick Filters can be user-defined. Quick filters allow you
to locate only the claims that match the selected Quick Filter criteria.

To edit user-defined claims criteria:
1. In themain menu header, click Claims > Track/Assign Claims. The claim tracking page opens.

2. In the View Tracking tab, ensure that Use Quick Filters is selected.

3. In the Select quick filters list, click the desired user-defined quick filter. The edit window for that
variable opens. In the following example, the Status variable options are being edited.
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4. Do any of the following as desired:
l To add a new option, click Add New. A new line is added to the table. Type the option in

the row.
l To edit an option, click in the row and make the desired change.
l To delete an option, click the blue cell to the left of the name and then click Delete.

5. Click Save.

6. Click Close.

Use filters in claim tracking
You can also use advanced filters in Claim Tracking.

To use an existing filter:
1. On the Claim Tracking page, click Use Existing Filter.

2. From the Select existing filter drop-down, select a filter.

You can build filters here as shown in the following example. Use the same steps as for building an
Advanced Filter in Reports.
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To build a new filter:
1. On the Claim Tracking page, click Use Existing Filter.

2. Follow the instructions in Build an advanced filter.

Assign claims from claim tracking
Assign claims from the Claim Tracking page by performing a mass modification.

To assign claims from Claim Tracking:
1. In themain menu header, click Claims > Track/Assign Claims. The Claim Tracking page opens.

2. Click theModify Tracking tab. This tab provides threemethods for selecting claims: Current View,
Quick Filters, or Existing Filters.

3. Select one of the following options and follow the provided instructions.

� Current View
Use this method to modify the tracking details of claims currently in the tracking page:

a. Click Use Current View.

b. In the Select modifications column, edit the tracking detail options.

c. ClickModify Claims. Also, if claims are in the Current View, you can sort the claims and
export them to MS Excel. You can sort on the current page, or, if there are numerous pages
of claims, you can sort the entire set. This option is boxed in green in the following example.
To the right of the Sort feature is another set of options. Here you select whether to export
the current pages or all pages in the set. Then, to export to Excel, click the Export List
button next to the View Claim(s) button, as shown outlined in red in the following Quick
Filters example.
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� Quick Filters
To use this method to mass modify claims:

a. Click Use Quick Filters.

b. In the Select quick filters column, specify the tracking details of the claims to modify.

c. In the Select modifications column, specify the new tracking details to apply.

d. Do one of the following:
l To modify the claims immediately, clickModify Claim(s).
l To review the claims found, click View Claims; then, if the returned dataset is

correct, clickModify Claims.

� Existing Filters
The Existing Filters list contains filters built in Claim Tracking, and advanced filters built in Reports.
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IMPORTANT: Use caution when using Advanced Filters from Reports to select accounts in
Claim Tracking. Basic report parameters require you to specify a contract to run your report
on as well as a discharge date range. The advanced filter does not necessarily specify a payer
or date range; therefore, your returned results may be for all payers for the entire database.
Modify by filters carefully and be sure to view your results before applying changes.

To use this method to assign claims based on existing filters:

a. In the Select existing filter drop-down, select a filter. Alternatively, you can click the Build
Filter button and build a filter from scratch, as explained in Build an advanced filter.

b. In the Select modifications column, specify tracking details to apply by editing the
modifications.

c. ClickModify Claim(s). This can also be done in two steps by first clicking View Claim(s).

� Customizing filters
As mentioned in Assign a claim, Axiom Contract Management includes ten User Defined fields, five of
which are formatted numerically and five of which are formatted as characters. You can also hide
columns to prevent them from entering claim tracking reports. For example, if you want to eliminate the
name field from claim tracking to comply with HIPAA regulations, contact a Kaufman Hall representative.

About grouping and pricing APC and eAPG claims
Many contracts include clauses or terms that include APC or eAPG reimbursement methods. Before
these contracts can be calculated, the claim line items need to be grouped and priced into APCs or
eAPGs.

Grouping and pricing can be a slow process when there are hundreds of thousands of claims, which is
why claims processing is usually done during the nightly import. However, you may need to group and
price claims on demand.
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The Group and Price Claims page in the Claims section of Axiom Contract Management enables you to
set up, save, and execute claim grouping and pricing tasks. Previously, all grouping and pricing took place
either by a member of Client Success or during the nightly import process on claims coming into the
system. Now you can run this process anytime on selected claims. For information, see Group and price
APC and eAPG claims.

Additionally, you can also use the Shift Date By feature to view a forecast of how new schedules will affect
claims for the coming year.

Group and price APC and eAPG claims
For contracts with clauses or terms that include APC or eAPG reimbursements, you can group and price
claim line items into APCs or eAPGs. You can also run a projection of what future claims will look like by
shifting dates on claims forward in time to understand the impact of new CMS grouping and pricing logic.
For information, see Shift claim dates for grouping and pricing forecasts.

NOTE: Your system must have licenses for APCs and/or eAPGs.

To group and price claims:
1. From the Claims menu, select Group and Price.

2. From theGrouping/Pricing Typemenu, select the desired option:
l APC
l eAPG

NOTE: Only options for which you are licensed display.

3. In Select claims by, select the desired option:

� Patient Account Number
a. In the Patient Account # field, enter the patient account number.

b. From the Claim Status drop-down, select the status of claims to include.

c. From the Simulation drop-down, select the simulation the claims are in.

� Claim Number/UCRN
a. In the Claim #/UCRN field, enter the claim number or UCRN.

b. In the Claim Status field, select the status of claims to include.

c. From the Simulation menu, select the target simulation for the claims.
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� Date Range
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

d. From the Claim Status drop-down, select the status of claims to include.

e. From the Simulation drop-down, select the target simulation for the claims.

� Contract
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

NOTE: You do not have to select Start and End dates if you want to work with the entire
time frame selected by the provision/version.

d. From the Claim Status drop-down, select the status of claims to include.

e. In the Contracts section, from the Current View drop-down, select the target simulation.

f. In the Contracts section, select the contracts to include. You can select an entire contract,
only certain versions of a contract, or specific provisions of a contract.

� Insurance Plan Code
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

d. From the Claim Status drop-down, select the status of claims to include.

e. In the Ins Plan Code table, from the Current View drop-down, select the target simulation.

f. In the Ins. Plan Code table, select the insurance plan codes to include. You can also select
an entire payor organization if desired.

4. Do one of the following:

l To perform the grouping and pricing now, click theGroup and Price button.
l To process the grouping and pricing later, save the selected claims as a grouping and pricing

task:
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a. In the upper right of the page, type a name in the field provided.

b. Click Create a Saved Task

A confirmation message displays that the grouping/pricing task has been queued to run or saved,
depending on your selection.

NOTE: If you selected to save the claims as a group and price task, your task is listed in the
Saved Tasks tab, where you can run it at any time.

Run a saved group and price task
These instructions are for running a saved group and price tasks from the Claims Group and Price Tasks
page.

To run a saved group and price task:
1. From the Claims menu, select Group and Price.

2. Click the Saved Tasks tab.

3. If needed, filter the list for the simulation and Task Type.

4. On the right side of the page, for the desired task, click Run Once.

The page displays a brief notification that the task was queued.

5. To delete a task when finished, in the row for that task, click Delete.
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Recalculating claims
Recalculation is the process in which a claim is filtered through the user-defined contract matrix to
generate a claim payment voucher and a total expected payment amount. You can calculate a claim in
Axiom Contract Management one of two ways:

l Nightly import process —Occurs during the import process and is done without any user
intervention.

l On-demand calculation —Users can perform ad-hoc claim calculation from the recalculate claims
interface, and also while viewing a claim from the Claim Detail page. Administrators can recalculate
claims from the Recalc History page.

Typically, every claim that enters the system calculates automatically during the nightly auto-import
process; however, there are times when you need to manually recalculate a claim using the ad-hoc
methods.

You might need to recalculate a claim for several reasons. Themost common reason is a contract term
modification. If a claim is calculated on a specific clause of a contract and that clause is adjusted in a way
that the claim nowqualifies for another clause or rate, a recalculation is warranted.

� Automatic recalculation
Every new claim entering the system that has a matching Contract → Version → Provision → Clause will
automatically generate an expected payment during the auto-import process. This ensures that new
information entering the system can be used during reporting and other analysis. No user intervention is
needed, but it is important to note that if the contract matrix is not kept up to date, then new claims that
enter the system will not generate an expected payment. It is also important to note that even though a
contract may exist for payer, if it is not modeled accurately, then the expected payment information will
probably be inaccurate.

Keep an eye on contracts approaching expiration and make sure to extend the expiration date (if
applicable), or model the new contract in Axiom Contract Management.

� Ad hoc recalculation
Recalculate a claim in the Recalculate Claims tab (Claims > Recalculate). You can recalculate claims by a
variety of criteria, such as the following:

l Recalculate by patient account number
l Recalculate by Claim Number/UCRN
l Recalculate by Date Range
l Recalculate by Contract
l Recalculate by Insurance Plan Code
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NOTE: You can also recalculate a claim from the Claim Detail page.

Recalculate a claim
Each of the following criteria give you more flexibility in determining which claims to recalculate.

l Patient Account Number and Claim Number/UCRN are typically used to calculate single
accounts/claims.

l Date Range and Contract allow you to select several claims at once for calculation.
l Insurance Plan Code allows you to recalculate all claims that have a specific payor code.

You select the claim to calculate in the Claim Type field. Your options are Institutional, Professional, or All.
Since professional claims are stored in Axiom Contract Management as separate bills, you must select
the appropriate Claim Type before calculating a claim.

The Claim Status field allows you to select whether to calculate on the Live accounts for a particular
account # or all accounts (Live and Inactive).

NOTE: Reports in the system are based on the Live accounts, so it is not always required to
recalculate inactive claims unless you are including those in your analysis.

To access Recalculate Claims:
In themain menu header, click Claims > Recalculate.

The Recalculate Claims page is displayed. Use the criteria explained in the following sections when
determining what to calculate.
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NOTE: You can also recalculate a claim directly from a claim’s Claim Detail page. For information, see
Recalculate a claim from Claim Detail.

� Recalculate by Patient Account Number
You can calculatemultiple accounts simultaneously by separating account numbers with a comma. If
there are claims that match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by account number:
1. In the Recalculate Claims tab, click the Patient Account Number option.

2. In the Patient Account # field, enter the account number.

3. From the Claim Type drop-down, select the type.

l Institutional
l Professional
l All

4. From the Claim Status drop-down, select the status:
l Live Claims Only
l All

5. From the Simulation drop-down, select the simulation.

6. Click Recalculate.

� Recalculate by Claim Number/UCRN

IMPORTANT: This option should only be used if you are using the system’s Claim Number / UCRN
feature.

If any claims match your criteria, a message displays that says the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by Claim Number / UCRN:
1. In the Recalculate Claims tab, click the Claim Number/UCRN option.

2. In the Claim #/UCRN field, type the number.

3. Select the Claim Type:
l Institutional
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l Professional

4. Select the Claim Status.

5. Select the Simulation.

6. Click Recalculate.

� Recalculate by Date Range
The date range option allows you to select all claims that fall between a specific date range and
recalculate them.

To recalculate by date range:
1. In the Recalculate Claims tab, click theDate Range option.

2. In theDate Type field, select the type of date:

l Discharge Date – Date the account was discharged
l Admit Date – Date the account was admitted
l Submission Date – Date the bill was submitted to the payer for reimbursement

3. For the Start Date and End Date fields, select the desired dates.

You can enter dates manually, or use the drop-down calendar. Clicking any date sets that as your
start/end date.
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4. Select the Claim Type:
l Institutional
l Professional

5. Select the Claim Status.

6. Select the Simulation.

7. Click Recalculate.

If there are claims that match your criteria, a message informs you that the recalculation task has been
queued successfully. If no claims match your criteria, a message informs you that no claims met your
selected criteria, and to try again.

� Recalculate by Contract
Selecting the Contract option allows you to select whole contracts. Calculating by contract gives you
added flexibility by allowing you to filter down into contracts, versions, or even to the provision level. For
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example, to calculate only an outpatient provision of a contract, you can drill down to that provision and
select it for recalculation.

In the following example, a user is recalculating provisions 1, 2, and 5 of their Cigna PPO contract, as well
as their entire KHAManaged Care contract.

Notice that the Contract option also includes the same features as the Date Range selection window,
allowing you to narrow your criteria even further.

To recalculate by contract:
1. In the Recalculate Claims tab, click the Contract option.

2. In the Contracts table, from the Current View drop-down, select the desired simulation.

3. Select the desired contract/version/provision to recalculate. You can select more than one.

4. In theDate Range section, enter the date range criteria (if you want to calculate the entire
contract, then entering date information is not required).

5. In the Enter a name for the task field, type a name for this recalculation.

6. Click Recalculate.

If any claims match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.
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� Recalculate by Insurance Plan Code
This option allows you to calculate claims for a single insurance plan code instead of calculating all the
insurance plan codes assigned to a contract version. For example, you can use this option when a new
insurance plan code has been added to a version and you do not want to re-process an entire version
and all plan codes, just the claims with the new code.

To recalculate by insurance plan code:
1. In the Recalculate Claims tab, click the Insurance Plan Code option.

2. In theDate Type field, select the type of date:

l Discharge Date – Date the account was discharged

l Admit Date – Date the account was admitted

l Submission Date – Date the bill was submitted to the payer for reimbursement

3. For the Start Date and End Date fields, select the desired dates. You can enter dates manually, or
use the drop-down calendar. Clicking any date sets that as your start/end date.

4. Select the Claim Type:

l Institutional
l Professional

5. In the Claim Status field, select whether to use Live claims or All.

6. In the In. Plan Codes table, do the following:
a. In the Current View field, select the desired simulation.

b. In the list of insurance plan codes, expand the organization and select the check box for the
desired code. You can select as many codes as desired. You can also select the parent Org.
code instead, which recalculates all claims that have that Org. code, including all the Payer
codes associated with that Org code.

7. Click Recalculate.

Save and schedule calculations
You can name and save calculation tasks and then schedule those tasks to run using the Axiom
Scheduler. This feature is great for repetitive calculations or when you need to schedule a large
calculation to run after hours or on a recurring, scheduled basis.

To save and schedule a calculation:
1. In themain menu header, click Claims > Recalculate.

2. In the Recalculate Claims tab, select the claim to calculate.

3. In the Enter a name for the task field, type a name for the recalculation.
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4. Click Create a Saved Task.

5. In the Desktop Client, in the Explorer task pane, access the Scheduler at Libraries > Scheduler
Jobs Library > Contract Management.

6. If needed, create a new job for the calculation. Please see Scheduler for more details regarding
assigning and completing jobs and tasks using the Scheduler.

You can access and run your saved tasks.

Run a saved recalculation task
You can rerun your saved recalculation tasks.
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To run a recalculation task:
1. From the Claims menu, select Recalculate.

2. On the Claims page, click the Saved Tasks tab.

The list of saved Recalculation Tasks displays all the saved tasks in all the simulations, by default.

3. If desired, from the Simulation drop-down, select the desired simulation to filter the list of tasks.

4. Locate the tasks to run and then, in the task row, click the Run Once button.

A briefmessage displays that the task has been queued to run, and the “0” in the Recalculations
Queued section changes to “1” (or the number of tasks you selected to run).

5. To delete a task, click theDelete button in the row for that task. In the confirmation dialog, click
OK. A briefmessage displays that the task has been deleted.

Recalculate a claim from Claim Detail
Users modeling contracts can now recalculate a claim from the Claim Detail page instead of using the
Recalculate Claims page if they want to recalculate just the claim they are viewing. This feature allows you
to recalculate a claim and then refresh the page to view the recalculation without having to navigate
between different pages and dialogs.

To recalculate a claim from Claim Detail:
1. From the Claims menu, select View a Claim.

2. Locate and view the claim.

3. In themenu on the left, click Recalculate.
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In the Recalculations Queued section (on the right in the blue header), the “0” changes to “1.”

NOTE: If you already have recalculations waiting in the queue, or if other users have
calculations waiting in the queue, the number is incremented. If you select another claim to
recalculate before the first one is finished, the number increments again.

When the “1” changes back to “0,” the recalculation is finished.

4. Refresh the page in your browser to view the recalculation results.

The data in the Last Recalc: field has changed to reflect the new recalculation date.
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For additional recalculation options or to recalculatemultiple claims, use the Recalculate Claims feature.

View claims recalculation history and rerun claims
Administrators can access a history page for recalculated claims. The Recalc History page contains a log of
all recalculated claims, whether recalculated in a batch or individually, and the ability to rerun any listed
recalculation.

The history includes:

l Recalc ID – Recalculation ID number
l Run By – Username of person/entity/process that ran the recalculation
l Start Date/Time – Start date and time of the recalculation
l End Date/Time – End date and time of the recalculation
l Claims Selected – Number of claims selected for recalculation
l Claims Processed – Number of Claims Selected that triggered a contract clause/term for payment
l Error Count – Number of errors that occurred during processing. Any errors found are displayed

at the bottom of the page in the Recalc History Errors section.
l Recalc button – Click to rerun any of the listed recalculations
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To access the Recalc History page, from themain menu, click Admin > Recalc History.

Verifying claims reimbursement calculation
Claims are automatically calculated during the nightly import process. However, theremay be cases in
which a claim does not calculate an expected reimbursement. Use the following list of checkpoints to
ensure that claims are calculated properly, and to help you figure out why an expected reimbursement
did not calculate as expected.
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Claim calculation checkpoints

� Step 1: Verify that the claim dates fall within the contract version Start and
Expiration dates
Navigate to the contract version and check the Start and Expiration dates. For a claim to calculate
correctly against a contract version, the dates on the claim must fall within the contract version’s date
range, which is its active period.

� Step 2: Verify that the Payer Code on the claim matches a code assigned to the
contract

1. In Ins. Plan Code column of the contract version, click the View/Edit button.

2. In the Insurance Plan Codewindow, look in the Payer Code column and confirm that the claim
insurance Payer Code is assigned to the contract:
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� Step 3: Verify that the Claim Bill Type is built into the contract version Provision
1. On the contract version row, click theDetails link to go to the Provision page.

2. On the Provision page, select the desired provision by clicking the blue square at the beginning of
the row. The row is highlighted light blue.

3. In the sidemenu, click Convert. The Provision Settings window opens, displaying the Types of Bill
on the provision. You may need to expand the top category row to see the underlying bill types,
as shown in the following example.

� Step 4: Confirm that the claim has criteria that match the contract build
1. Review the claim and compare the criteria to verify that it matches the capture data specified on

the contract clause/term.

2. Check that the contract also has a clause that captures non-reimbursable claims. In addition to
criteria that catches reimbursable claims, each contract should have a final clause that captures
non-reimbursable claims. Without a capture clause/term, the claim will not calculate expected
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reimbursement. In the following example, a No Qualifying clause is used.

Administrator's Guide Axiom Contract Management │ 149



Working with Standard Reports
This chapter covers building a standard report.

Access standard reports
Use these instructions to access standard reports in Axiom Contract Management.

1. In themain menu header, click Reports > Reports.

The Reports page opens to the Report List tab. All previously saved reports are located here.

7
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2. Do one of the following as desired:

l To create a new report, click theNew tab, and then follow the instructions in Create a new
standard report.

l To view an existing report, select the report from the list and then click the View/Edit tab.

Create a new standard report
Use these instructions to create a new standard report.

To create a new report:
1. In themain menu header, click Reports > Reports.

2. Click theNew tab.

3. In the Report Name field of the new report form, type a name for your report.
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4. From the Report Type drop-down, select the type of report template to run.

5. Select a report date range. The report parameters available depend on the selected report type.
All reports have a date range parameter. You need to set a Start Date and an End Date for the
report.

a. In the Start Date field, click the drop-down and select a date from the calendar.

b. In the End Date field, click the drop-down and select a date from the calendar.
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6. If the type of report you are creating requires you to select a contract against which to run the
report, from the Contract drop-down, select an existing contract.

7. If the type of report you are creating requires other parameters, these display in the Parameters
section. Select any that apply to your report.

8. To add filters to your report, in the Parameters heading bar, click the arrows to the left of the
Advanced button. Do one of the following:

l From the Filter drop-down, select a filter.
l Build a filter.

9. Click Save. The report generates.

View a standard report
After the standard report is processed, the system displays the report in theWeb Client. The initial view
is the detailed view, meaning most of the rows are expanded, except for themost granular level; those
usually are collapsed, with a boxed plus symbol to the left of the rows. Expanded rows have boxed minus
symbols to the left.

To change the view of a report:
l To expand the details for an item, to the left of the item, click the plus symbol (+) (outlined in red in

the following example).
l To access a claim from a report, expand the account row and then click the account number link.
l To view selected filters, on the left above the blue report column headings, click the plus symbol

next to Selected Filters.

NOTE: These are not the same as Advanced Filters.

l To hide report details, click theHide Detail check box(outline in green in the example) and then
click Save. Report details usually include themost granular level of detail in a report, such as
individual claim level account numbers and patient account information.

l To change the size of the report on the page, select an option from the Page Width drop-down
(outlined in orange in the following example).
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Report example

Export a standard report
Exporting reports to Microsoft Excel can be a useful tool for additional claim and data analysis. Exporting
to Excel allows you to perform enhanced data sorts, comparisons, calculations, and edits.

To export a standard report to Excel:
1. Navigate to the desired report.

2. In the gray toolbar at the top of the report, click the Export to drop-down, and select Excel.

A Download button displays to the right of the export drop-down, which now displays as “Excel.”

3. Click Download. The Excel file name displays in the lower left corner of the page. Click the file to
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open it.

4. In Excel, you can expand report details similarly to the way you do in Axiom Contract
Management: by clicking on the plus icon (+) to the left of an item.

Example report with expanded filters

5. To expand all filters, click the number of highest value in the group that sits just above and to the
left of cell A1.

Each greater number represents a deeper level of expansion. In the image below, number 5 has
expanded the report down to the claim level.
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Example of fully expanded report

Edit or delete a standard report
Use these instructions to modify and save an existing standard report, or to delete a standard report.
You can make changes incrementally if you want, by saving the report after each parameter change.

These instructions are generalized; not all reports contain the report parameters used in these
instructions, and some reports contain parameters not mentioned here.

NOTE: You cannot change a report’s type.

To modify a standard report:
1. In the Report List tab on the Reports page, click the report to edit and then click the View/Edit

Administrator's Guide Axiom Contract Management │ 156



tab.

2. To change the report name, in the Report Name field, type a new name.

3. To change a date parameter, expand the Parameters section if needed, and then select a new date
range from the start and end date drop-downs.

4. To change the report’s simulation, in the Simulation drop-down of the Parameters section, select
a different simulation.

NOTE: If you change the simulation, you may be required to change the contract as well, since
contracts are simulation specific.

5. To change the contract, in the Contract drop-down of the Parameters section, select the desired
contract.

6. To add a filter to the report:
a. Click the arrows to the left of the Advanced button to open the Advanced parameters.

b. From the Filter drop-down, select the desired filter.

7. Click Save.

To delete a standard report:
1. In the Report List tab on the Reports page, right-click the desired report and select Delete.

2. In the confirmation dialog, click OK to delete the report.

Run APC and eAPG Edits Reports in any simulation
You can run APC/eAPG edit reports targeting a simulation environment other than Live. Although there
is a Simulation drop-down menu for this report, previous to the 2019.1 release, the report always ran on
the Live simulation for APC/eAPG reports, regardless of the simulation selected. Now you can view edits
that occur on APC and eAPG claims grouped within any given simulation.

To run an APC/eAPG Edits report:
1. Click Reports > Reports.

2. Click theNew tab.

3. In the Report Name field, type a name for this report.

4. From the Report Type drop-down, select one of the following:
l Edits - EAPG
l For APC, Edits - OCE APC.

5. Expand the Parameters section if needed, and select a Start Import Date and an End Import Date.

6. From the Simulation drop-down, select the desired simulation.
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7. From the Contract drop-down, select the desired contract(s).

8. Click Save.

The report generates.
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Working with drill-down reports
Axiom Contract Management’s drill-down reporting feature enables you to createmulti-level, complex
reports with expandable / contractible sections. Drill-down reports are interactive and highly modifiable.
After generating a report, you can sort and rearrange columns, add or delete additional rows or columns,
apply or remove filters, etc.

Accessing drill-down reports
To access Drill-Down Reports:

l In themain menu header, click Reports >Drill-Down Reports.

Drill-Down Reports opens in a new browser tab. To get started, see Organizing drill-down reports.

8
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Organizing drill-down reports
The initial page displays your organization’s drill-down report folder structure that stores all previously
saved reports. From this page, you can add a new folder to the structure, search for and open a saved
report, or click Create New Report to access the report builder.

Drill-down reports page example

The system comes with the following folders:

l Claims
l Line Items
l 835s

You can add and delete folders, and create additional subfolders as desired.

IMPORTANT: Be aware that when you make a change to any of the folders, it affects all users.

This initial set-up categorizes reports by type of report. Other options may be User Name or Department.
How facilities use the folder structure is up to them.

� Add report folders
First determine whether the new folder should be for a new category or a subcategory.

To add a new category folder:
1. In the Categories panel on the left, click +Add New.

This creates a new folder named NewCategory# that you can rename.

2. Rename the new category and then press Enter.

The new folder sorts alphabetically into the structure.
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To add a new subcategory folder:
1. In the list of categories, right-click the existing category, and select Add New.

2. Rename the subcategory, and press Enter.

If a category has subcategories, an arrow icon (>) displays to the left of the Category name. To
display all subcategories, click the arrow.
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� Edit or delete report folders
You can rename or delete report categories and subcategories.

To rename a category or subcategory:
1. Right-click the category, and select Rename.

2. Change the name, and then press Enter.

To delete a category or subcategory:
1. Right-click the category, and select Delete.

2. In the confirmation dialog, click OK.
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� Edit the folder structure
You can rearrange folders and subfolders by dragging and dropping them to new locations. You can
move reports within folders the sameway. Just keep in mind that any changes you make to a folder’s
structure or contents affects all users.

To move a folder to a different category folder:
l Drag a folder or subfolder to another category folder. Release themouse button when the

destination folder name changes color.

In the following example, the user drags the Line Items folder to the Department Denials folder.

� View the list of reports in a folder
To see the reports saved in folders:

1. Click the folder name. The reports display in the right pane under the name of the folder.
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2. To view summary details about a report, click the report name.

An information box displays just below the report name, showing more details about the report,
including the dates the report was created and last modified, the name of the user who modified
it, and any notes that were added when the report was saved.

3. To close the summary details box, click the name of the report again.

� Edit report summary information
In addition to viewing report summary information, you can edit the report name, description, and
folder location.

To edit report summary information:
1. To modify the report name, description, or folder location, on the left of the description, click Edit

info.
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2. In theUpdate Report Detail dialog, edit the desired information, and then click Save.

Configuring drill-down reports
When you view a report with the Columns panel open, the Groupings and Measures tabs display on the
left side of the page. (By default, opened reports initially display with the Columns panel closed.)

Report shown in flat view

These tabs contain all of the data elements available for building reports. When building a report, always
select at least one item from Groupings and at least one item from Measures.
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� Organizing groupings and measures
When organizing groupings and measures, you can use the provided folder structure or create your
own. You can customize the tabs by adding, deleting, and rearranging folders to organize the groupings
and measures data elements as you wish. The folder structure built by one user has no effect on any
other user, nor does how you choose to organize the data elements. However, data elements remain
within their designated tab, Groupings or Measures, and sort alphabetically within their folder. Measures
sort alphabetically first by standard measures, then by calculated fields.

To create a new folder:
1. Determine where the folder should be created.

l To create a main folder, click Groupings (orMeasures), and then click Add New.
l To create a subfolder, first click themain folder, and then click Add New.

A new folder displays, prompting you to name it.

2. Type in the name and press Enter.

In the following image, Dates is a main folder containing two subfolders: Admit and Discharge.

To delete a folder:
1. Click the selected folder.

2. At the top of the tab, click Delete.

3. In the confirmation dialog, click OK.

NOTE: You cannot delete a folder with contents. Delete or move the folder’s contents and
then delete the folder.

To move data elements between folders, do either of the following:
l Drag-and-drop the data element from its current location to the new folder.
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l Right-click the data element, and click Cut. Then right-click on the new folder location, and click
Paste to move the data element.

About drill-down report fields
The following fields are used in drill-down reports.

� Groupings
These fields display as a grouping of rows in the report, in column format. All information requested in
the report is totaled by the selected Grouping. In a report, the first grouping displays as the first column.
Any additional groupings selected are a subgroup of the first grouping picked.

� Measures
These fields display as columns in the report.
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Threemain functions are available to calculate a measure: sum, average, and count. You can also choose
to display themaximum or minimum value for the field.

Measure names displayed in black text are standard measures in the system. Measure names in blue
text are user-defined calculated fields, as shown in the following example.

Calculated fields are listed alphabetically beneath the standard measures in the folder they are saved in.
You automatically see calculated fields in your display. Calculated fields created by other users default to
the folder “Other Users’ Calculated Fields,” which is a subfolder ofMeasures.
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Calculated fields are used to create custom measures in the system. For instructions on creating
calculated fields, see Add calculated fields to a report in Building reports.

� Add Filters
Use the Add Filters button to select specific criteria from the database to incorporate into a report. Note
that a filter is not required to run a report. However, if no filters are applied, the entire database is
queried.

The Add Filters button displays on the bottom right of the page when you open a drill-down report or
edit or create a drill-down report.

See the report building example in Building reports for details on applying filters.

� Claims tab
The Claims tab pertains to all information found on a claim. This information is only available for claims
filed and subsequently imported into Axiom Contract Management. The available Groupings and
Measures are provided in the Columns panel on the left side of the page.

Use the Claims tab to report claim and contract information. You can generate reports to analyze actual
contract performance as well as expected profitability using expected payment information. You can
generate Detailed Tracking Reports to track underpayment recoveries by payer.

� Line Items tab
The Line Items tab provides details from the claim form at the line item level. Only patients whose claims
were filed and subsequently imported into Axiom Contract Management are available. The available
Groupings and Measures are listed in the Columns panel on the left side of the page.

Use the Line Items tab to report on data at the line item level, including Revenue Code, Service Date, and
Quantity detail.
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� Applied Filters
The Applied Filters button is located at the bottom left of the page. The Applied Filters window displays
all of the filters applied to the current report.

l To display all the filters from the Claims, Line Items, and 835 Tabs that you selected to apply to the
current report (see the following example), click the up arrows on the Applied Filters button.

l To delete a single filter, click to the left of the value, and press theDelete key.
l To remove all filters, click Clear All on the right of the page. If no filters are attached to a report,

the system will search the entire database for results.

Viewing drill-down reports
All saved reports are available when you first open Drill-Down Reports. The Category section on the left
side of the page contains the folders in which saved reports are stored.

� Open a saved report
To open a saved report:

1. In the Categories panel, click the folder where the report is stored.

2. Hover your cursor over the report name, and click View.
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The report generates and opens.

After generating the report, you can edit it, change the design view, or export it to Excel. Building
and editing reports is covered in Building reports.

3. When finished viewing the report, to return to themain Drill-Down Reports page, in themenu bar,
click Reports >Open.

To open a saved report while working elsewhere in Drill-Down Reports:
1. In themenu bar at the top of the page, click Reports >Open.

You are taken back to the Drill-Down Reports opening page.

2. Click the folder in which the report is stored.

3. Hover your cursor over the name of the report, and click View.

� Open and close the Columns panel
When you open a saved report, the system generates the report and displays the results using the full
page. In this view, you do not see the Groupings and Measures tabs in the Columns panel because the
panel is minimized.

To maximize the panel, click the arrow to the left of the results. In the following images, the one on the
right shows the bar the arrow resides on in blue. You can click anywhere on this bar to maximize and
minimize Columns panel.
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Likewise, while working with a report, you can minimize the Columns panel by clicking on the same bar,
as shown in the following example.
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Building drill-down reports
Use the NewReport page in Drill-Down Reports to create new drill-down reports. To update existing
reports, see Editing and filtering drill-down reports.

Build a new drill-down report
Use these instructions for building a new drill-down report. Creating a report that has filters, and saving it
in the drill-down interface, saves the advanced filter.

To build a new report:
1. Do one of the following:

l Near the top of the page on the right, click Create New Report.

Administrator's Guide Axiom Contract Management │ 173



l In the header menu, click Reports >New.

2. Of the tabs on the right side of the page (Claims, Line Items), click the tab for the type of data
being retrieved. The Claims and Line Items tabs contain information found on the patient’s UB04
or 837 claim forms, and resides within Axiom Contract Management.

On the left side of the page are two tabs, Groupings and Measures.

NOTE: You must select at least one parameter from both tabs to generate and display a
report.

3. On the left side of the page, in theGroupings tab, click the plus sign (+) to expand any folders as
needed to locate report groupings options.
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4. Double-click a groupings option to add it to the report. When added, that option displays on the
right side of the page above the Generate button, as shown in the following example. Select more
row groupings if desired.

NOTE: If you select more than three groupings, only the first three display when you generate
the report in hierarchical view. All groupings display when you generate a report in flat view.
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5. Click theMeasures tab, expand any folders as needed, and then double-click the desired
measures, one at a time, to add them to the report. If you do not see themeasure you need, you
can create one. See Add calculated fields to a report.

l To add a measure to the report as SUM of that measure, double-click themeasure.
l To add a different calculation, right-click themeasure, and select a calculation option from

themenu as shown in the following example.
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When you chose the calculation option for the desired measure, the selected measure
displays to the right of the selected grouping. This is the order in which the columns in the
report display. You can rearrange them or delete a grouping or measure before or after you
generate the report if you change your mind.

l To remove any selected options from the report before generating, right-click the option,
and select Delete.

l To rearrange report columns, drag and drop the columns to the desired order. In the
following example, the user drags themeasure COUNT claims to themiddle row. The red
arrows showwhere themeasure label will start, which in this example, is after Payer Code:

6. In theData View section to the right of the Generate button, select the report grid type:
l Hierarchical – Select this option to display the report with grouping columns arranged in a

hierarchy.
l Flat – Select this option to display the report with grouping columns arranged side-by-side.

7. Click Generate.

8. If desired, save the report so you can use it later.
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Add calculated fields to a report
If you need a measure that does not exist, you can build a calculated field. You create calculated fields by
choosing current measures and creating expressions with mathematical functions to calculate the
desired results.

To create a calculated field:
1. Open the drill-down report to which you want to add a calculated field. If you are creating a new

report, select the tab for the type of report (e.g., Claims or Line items).

2. In themenu bar at the top of the page, click Reports > Create Calculated Field.

The NewCalculated Field window opens.

NOTE: You cannot use a calculated field in an equation for another calculated field.

3. Do one of the following:
l To use filters from a saved report, click theUsing option and then select a report from the

drop-down list. Reports available in this list are based on the tab that you are on when
building the calculated field. A calculated field on the Claims tab can only use the filters from
other Claim reports.
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NOTE: Using the filters option limits the calculated field to only the claims found in the
selected saved report. For example, to compare pediatric claims to all claims, you need
to create a calculated field for SUM(claims) with a filter from a report limited to pediatric
claims. You can select only one report to apply as a filter to a calculated field. However,
the report used for the calculated field can contain as many filters as you need.

l If you do not want to use a filter, leave the default Not using selected.

4. Build the expression by selecting measures from theMeasures list on the left:
a. Click the desired measure, and select the desired function from the list of available

functions. Themeasure is added to the Expression box. Now you need to add an operator
or mathematical symbol.

b. Click the Functions button to select the desired operator, or, for a mathematical equation,
use themathematical symbols on your keyboard (+ - / *) for add, subtract, divide, and
multiply, between your measures to string them together.

NOTE: Do not use special characters, such as dashes and slashes, in a calculated field
name.

TIP: If you make a mistake with the expression, click Clear All and start over.

c. Add the next measure and symbol, as needed, until your expression is complete.

TIP: If you know the complete expression, you can type it into the Expression box
manually instead of selecting Measures and Functions from themenus.
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d. Click Save.

e. In the Save As dialog, select a location to store themeasure on theMeasures tab, and then
in theName field, type a name for it.

f. Click Save and Return.

The newmeasure name displays in blue text on theMeasure tab in the folder you selected.
The name becomes a column header when added to a report.

Edit or delete a calculated field
Use these instructions for managing your calculated fields.

To edit a calculated field:
1. In the Columns panel, click theMeasures tab.

2. In theMeasures list, right-click the desired calculated field, and select Edit Calculated Field.

3. In the Edit Calculated Fieldwindow, do any of the following as desired:
l To clear the entire expression in the Expression box, click Clear All and then rebuild the

expression.
l To replace part of the expression, use the backspace key to remove the part you want.
l To add a measure, in theMeasures list, click the desired measure, and select the calculation

type from the pop-up menu.
l To add an operator between measures, type a mathematical symbol (+ - * /) or click the

Functions button, and select a function.
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4. Do one of the following:
l To save themeasure as a newmeasure, click Save As and then, in the Save As window,

select a location for themeasure. In theName field, type a new name. Click Save and
Return.

l Click Save.

To move a calculated field:
1. Right-click the calculated field, and select Cut.

2. Select the desired location / folder in theMeasures tab, right-click and select Paste.

TIP: You can also drag and drop calculated fields to different locations in theMeasures tab.

To delete a calculated field:
1. In theMeasures tab, right-click the calculated field, and select Delete.

2. In the confirmation dialog, click OK.

NOTE: You cannot delete calculated fields that are attached to a report.

Apply filters to a drill-down report
These instructions explain how to apply filters while building a report. This is when you set the criteria for
selecting data from the database.

To apply filters:
1. On the bottom right of the page, click Add Filters.

2. To change the type of filter you are applying, click the Filter by drop-down, and make a selection
(see the following example). Each type has an underlying folder structure that groups together
similar data elements.

3. In the Fields section, click the plus symbol (+) next to the type of field you want, to view the fields
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available in that folder.

4. To select a filter to apply to the report, click the filter name.

For some filters, a list displays of the data values you can select for that filter.

For other filters, a drop-down list provides selection options:
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� To search for filter values:
l Do one of the following:

o Scroll down the entire list until you find the desired value, then click the check box
next to the value, and click theUse These button on the right to save the value.

o If you know the exact value to filter with, type it into the box, and then click Filter.
The system displays this value. Click the box and then click Use These to apply the
filter.

o Use the wild card feature. If you do not know the exact value for the filter but you
know some or part of the value, type the percent (%) symbol in the field along with a
known portion of the number/text, and click Filter. This shortens the list of values to
search from. For example, to find a certain ICD Procedure number that relates to the
heart, type “%heart.” The system provides all the ICD Procedure codes that include
the word “heart” in the description. Select the desired value(s), and click Use These.
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l Additionally, you can select more than one filter value by selecting multiple check boxes.

l To select all of the values except one, click Check All, which selects all of the filter values.
Then, you can simply uncheck the values that you do not want to use in the report.
Remember to click Use These to set the filter.

5. Each time you select a filter, click Use These to set this filter for the report.

6. After selecting the desired filters, at the bottom left of the page, click Applied Filters to view the
filters and confirm the selected criteria.

7. After adding all of the groupings and measures to the design view and applying the filters, click
Generate to view the results. The results of the report display.
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Save a drill-down report
Saving a report saves all of the selected groupings, measures and filters, and any changes to the report
format or layout.

We recommend that you save the report while viewing the report layout. This ensures that the report is
saved as the correct type (Claims or Line Items).

Report layout view
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To save the report:
1. In themenu header at the top of theDrill-Down Reports page, click Reports > Save.

The Add NewReport window opens. The Tab field defaults to the Report tab that you were on
when you saved the report.

2. In the Folder field, select the folder in which to save the report.

3. In theName field, type a unique name for the report. Give the report a name you can easily
remember and identify later.

NOTE: When naming a report, do not use special characters such as dashes or slashes.

4. If desired, in theDescription field, type a detailed description of the report.
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5. Click Save.

You can continue to work on the report and either save the changes or select Save As to save as a new
report with a new name.

Export a drill-down report
Use these instructions to export a copy of drill-down report results to Microsoft Excel, which transfers the
report into an Excel spreadsheet.

The system defaults to Export Row State (Expanded or Collapsed) and Export Filter Information. If you do
not want to export any of these features, highlight and click the desired setting to clear the check mark.

To export a drill-down report:
1. Generate the report.

2. In menu header above the report results, click Settings > Export to Excel, and then select the
following as desired:

l To include the ability to expand entire row levels at a time, click Export Row State
(Expanded/Collapsed).

l To include a list of filters applied to the report in the report results, click Export Filter
Information.

l To verify your selections, click Settings > Export to Excel.
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Selected options display a check mark to the left of the option:

3. Below the dark gray menu header, click the blue Export link.

The report generates. This may take several minutes if the report is long.

The report file downloads to your computer, and a link to the file displays in the bottom left
corner of the page, as shown in the following example.

4. At the bottom of the page, click the Excel file to open it.

The following example shows a report generated in hierarchical view that was exported with the
options Export Filter Information and Export Row State (Expanded/Collapsed) selected.

The applied filters export as a collapsible list above the report results, for reports in flat view and in
hierarchical view (see list outlined in red in the following example).

Each report level has its own expand/collapse button ( ) to the left, which you can use to
expand and collapse report sections.
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On the left, above the list of filters, is a row of numbered squares (outlined in blue in the following
example). Use these buttons to expand/collapse all rows of the level that corresponds to each
button.

5. To view report details, do any of the following:

l To expand/collapse individual rows, click that row’s buttons ( / ).

l To expand all level 1 sections, click the second square ( ) in the row.

l To expand all levels, click the last square in the row, which is the third square ( ) in the
example.

l To collapse all expanded sections, click the first square ( ).

Editing and filtering drill-down reports
Drill-down reports are interactive, allowing you to filter the report to display only what you want.

Report filtering options
Several buttons, icons, and drop-down menus display in rows above the gray shaded field names on a
generated report. These functions allow you to further edit the report.
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� Limit button
The Limit button sets additional report filters. For example, to display results for Emergency and Urgent
only, select the check boxes to the left of their names, and click Limit.

This sets these Admit Type selections as an additional filter. They will be the only results displayed:

To remove applied limits, see Remove an applied filter.

� Rows menu
Use the Rows menu to make selections from the results. For example, if you sorted charges in
descending order to reveal the Admit Sources with themost charges and you are only interested in the
top five Admit Source, click Rows > Select > First 5, which selects the first five names displayed.
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l To display the top ten, go back to Rows > Select >Next 5, which selects the next five Admit
Sources listed.

l To display only the top four Admit Sources:

a. Select Rows > Select >None; this clears all of the selected Admit Sources.

b. Manually click the top four in the report. When all desired Admit Sources are selected, click
Limit to remove all of the non-selected Admit Sources from the view, displaying only those
selected.

NOTE: When you select and limit rows of data from the results, this information is set as a
filter, which is then visible in the Applied Filters window. If you make an error, open the
Applied Filters window, and remove the new filter.

You can also use the Rows menu to expand and collapse sub-grouped rows when a report uses multiple
groupings.
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� View menu
Change the grid type between Hierarchical and Flat. This is the same as selecting Flat view or Hierarchical
viewwhen viewing the report in design view.

For examples of how to use these views, see Add a grouping as a subtotal.

� Settings menu
Use this menu to set the formatting for reports exported to Excel.

For instructions on exporting a report using this menu, see Export a drill-down report.

� Design View
Design View is report-building view. In Design View, you can add, delete, or rearrange the groupings and
measures in a report. Although the following example shows a new report, you can edit existing reports
in Design View. For instructions, see Change report column order.

Groupings and measures are added to the system in the order they were selected, with groupings placed
beforemeasures. However, you can change the order of groupings and measures at any time (groupings
still order together beforemeasures). For instructions, see Change report column order.

Sort report columns and rows
When building a report, you can easily sort report columns, and rearrange report columns.
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After generating a report, you can modify the results using various functions. For example, you can alter
or sort data, add or delete additional rows or columns, or continue to drill down into the report to view
more specific results.

As an example, the following image displays partial report results using the following criteria:

l Filter: DRG = 291, 292, 293
l Grouping: Admit Source
l Measures: Sum Claims, Sum Total Charges

To sort report columns:
l Click one of the gray report column headings. A small up or down arrow displays to the right of the

column name to indicate the column is sorted in either ascending or descending order.
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l You can also sort columns by right-clicking a column heading and selecting Sort, and then from
the pop-up menu, selecting Ascending or Descending.

l Right-click a measure heading to get the same options, and to select a decimals option which,
when highlighted, lets you adjust the number of decimal places displayed in your data, as shown
in the following example.
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Add a grouping as a subtotal
When you build a report with more than one grouping, the system subtotals the second grouping
underneath the first. For example, to see all of the Bill IDs associated with each Admit Source, double-
click the Bill ID field in theGroupings tab. The system displays the following:

After generating, the report displays a plus symbol (+) to the left of the check box in each row:

To display all of the rows that subtotaled under a field value, click the plus symbol (+). You can sort or
delete these subtotaled rows, as well as sort the columns.
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When building reports with multiple groupings, the system defaults to the Hierarchical view as seen in
the previous image. This is one of two views available for displaying data. The other is the Flat view. The
Flat view displays groupings side-by-side, as shown in the following example.

NOTE: Reports with more than three groupings must be run in the flat view. Also, while the
hierarchical view subtotals the groupings, the flat view does not provide totals.
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To change from the default Hierarchical view to the Flat view, do one of the following:

l Before clicking Generate to run the report, instead, for Data View, click the Flat option.

l After the report is generated, from the View menu, select Grid Type > Flat.

Notice that in the following example, Hierarchical is the view being displayed. Likewise, if the
results display as Flat, you can follow the same steps to change it to Hierarchical.

Change groupings
After building and generating a report in hierarchical data view, you can change groupings without
having to delete the field, add the new grouping, and regenerate the report. You can use the drop-down
arrow immediately to the right of the first grouping to select the new field.

When a report is in hierarchical view, the first grouping is a drop-down selectable field, which makes it
easy to change it to a different grouping.

To change the first grouping for a report displayed in hierarchical data view:
l In the first column heading, click the drop-down arrow to the right of the column name, then

locate and click a different grouping.
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First grouping with drop-down arrow outlined in red

Selecting a different grouping from the list

The report regenerates with the new data, as shown in the following example:
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Notice that the data have changed in the two measure columns because themeasures now apply
to the new grouping.

Change report column order
Use design view to change the order of a report’s groupings and measures columns before or after
generating the report. You can also remove groupings and measures from your report in design view.

NOTE: Groupings always precedemeasures in report layout, regardless of how you order them. You
can re-order groupings within a report’s set of groupings, and re-order measures within the report’s
set ofmeasures. You cannot put a measure before any grouping, however. Even if you do, when the
report generates, themeasure will be grouped with the other measures in the report.

To access design view without opening the report:
1. On themain Drill-Down Reports page, in the Categories panel, click the folder where the report is

saved.

2. On the right side of the page, click the name of the report to open the report summary
information box.

3. On the left side of the summary information box, click Design.

The design view of the report opens on the right.
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To access Design View from an open report:
l Above the report, click Design View.

To change the order of groupings or measures:
1. Click the grouping or measure to move and drag it to its new location.

2. When the two red arrows display in the desired position, release themouse button.

Themeasure columns are now in the new order:

To remove groupings or measures from the report:
l Right-click themeasure or grouping to remove, and click Delete.

Remove an applied filter
When filtering drill-down report results, you may apply a filter that you later want to remove rather than
recreate the report.
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To remove an applied filter:
1. At the bottom left of the page, click the arrows to the left ofApplied Filters.

The Applied Filters window opens, showing the filters currently applied to the report.

2. To clear a single filter, click the blue box to the left of the filter, and then press theDelete key. The
filter is removed.

3. To clear all filters, click Clear All.

To close the filter box, click the arrows to the left ofApplied Filters.

When the filter box closes, the report automatically regenerates with the updated filters.

Delete a saved drill-down report
You can delete reports you no longer need.

To delete a drill-down report:
1. From the entry Drill-Down Reports page, find the desired report.

2. Right-click the report, and select Delete.
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3. In the confirmation dialog, click OK.

IMPORTANT: If you accidentally confirmed a deletion, you need to recreate the report; a
deleted report cannot be retrieved.

Reporting across tabs
Reporting across tabs allows you to createmulti-sided reports and conduct multi-dimensional analysis.
For example, to see the admit source of claims that include a specific administered drug, you need to
include Line Item filters in your claim report. The drug code is stored with the charge data, while Admit
Source is a reportable field on the Claims tab. From the Claims tab, you can also find the number of
claims and their associated charges, and payments, (see following example). This methodology works for
the other tabs as well.

To report across tabs, you create a multi-tab report, as explained in the following section.

� Create a multi-tab report
The following example uses a Claims tab report. The steps are outlined from the perspective of using the
Claims tab only. However, you can add filters from any tab.

To build a multi-tab report:
1. Open an existing report or create a new one.

2. At the bottom right of the page, click Add Filters.

The Advanced Filters window opens.

3. From the Filter by drop-down, select Line Items. This sets a Line Items tab filter without you
needing to switch tabs.

4. In the Fields panel, expand theDemographic folder, and select Line Item Code. In the right side
of the window, Line Item Code values display with their descriptions.
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5. Click the check box for each Line Item Code filter to apply to the report, and then click Use These.

In the following example, the user searched for a certain kind of drug by using the wildcard search
“%furo%”, which returned two kinds of injection drug.

6. Close the Advanced Filters window.

7. To confirm your selected filter(s), at the bottom left of the page, click Applied Filters. In the
Applied Filters window, review the applied filter(s).

Setting a Line Items filter causes the system to automatically filter through the database so that
only claims information related to the criteria selected from Line Items is accessible.

8. Close the Applied Filters window by clicking the arrows to the left ofApplied Filters.

9. In the Columns panel, on theGroupings tab, double-click Admit Source.

10. Click theMeasures tab.

11. Double-click the following: Claims, Total Charges, and Total Payments to add them to the report,
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calculated as SUM.

12. After selecting all desired fields, click Generate.

The results show the Admit Source and the number of claims that have administered the selected
drug, along with all associated charges and payments.

NOTE: If you add a new filter that limits the Admit Source on the Claims tab, the Applied Filters
tab shows the filters from both the Claims and Line Items tabs, separating them by filter type.
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� Save a multi-tab report
You use the same process to save a multiple-tab report as when saving a single-tab report. However, it is
important to note the tab you are on when you save the report. The Applied Filters from each tab is
saved; however, the report will only save the Rows/Columns of the tab you are viewing at the time that
you save the report.

In the previous example, if you switched to the Line Items tab before saving, saving the report while on
the Line Items tab would save only the filters, not the selected Admit Source, Claims, Charges, and
Payments from the Claims tab. However, saving from the Claims tab will save the Row/Columns you
selected and all filters applied to the report, regardless of the tab they are associated with.

Using report sets
The Report Sets feature allows you to create single or multi-report workbooks and to schedule them to
run automatically, one time or on a regular basis.

When you run reports from the Report Sets window, the generated reports are automatically exported
to Excel and saved to a selected directory accessible from the Axiom Desktop Client. The default directory
is Axiom > Reports LIbrary > CMAData > ReportSets. From this directory, you can view, save, export, and
delete reports.
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Create a report set
Use these instructions to create set of drill-down reports.

To create a Report Set:
1. In themain menu header, click Reports >Drill-Down Reports.

2. On theDrill-Down Reports page, click Reports > Report Sets.

3. At the bottom left of the Report Sets window, click Add New Report Set.

A new row displays at the bottom of the Report Set grid.

4. In theName column of the new row, type a name for the new report set. The name of the report
set will also be the name of the report file that exports.

NOTE: Do not use any spaces or special characters in the report name. Limit the title to 15
characters because this is used for the workbook name.

5. If desired, click in theDescription column for the new row and enter a description of the report
set. Spaces and special characters are allowed in the Description field.

The Last Run At column displays the last time the report ran through the Scheduler.

6. To enable the report set to be scheduled to run at a set time, select the Enabled checkbox.

7. At the right end of the new report row, click Save.

8. In the confirmation dialog, click OK.

The Report Set saves to the grid in alphabetical order.
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9. Next, add reports to the report set.

Add reports to a report set
Use these instructions to add reports to an existing report set, and to set up headers and footers for the
generated reports.

To add reports to the report set:
1. In the Report Set table, find and select the report set.

2. At the top of the Report Sets window, click the Sheets tab.

3. On the Sheets tab, at the bottom left, click Add New Sheet. A new row is added to the Sheets
table.

4. Click in theQuery Name field, and then from the drop-down menu, select the drill-down report to
add.

5. In theWorksheet Name field, type a name for the worksheet. Worksheet names become the
names of the tabs used in the generated report.
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All reports, regardless of type (Claims or Line Items), are listed here alphabetically. Each added
report will be an additional sheet in the report set Excel workbook.

6. Near the right end of the new row, click Save.

7. If desired, you can add header and footer information to the sheet. See the following instructions
“Add headers and footers to reports in the set.”

8. Run and view the report, or schedule the report set to run at another time.

� Add headers and footers to reports in the set
To add header and footer information to the sheet:

1. In theHeader/Footer column for the new sheet row, click Details.

2. In theHeader Details section, type the desired information into the fields that corresponds to the
section of the header where you want the text to display.
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3. In the Footer Details section, type the desired information into the fields corresponding to the
footer sections (Left, Center, Right) where you want to place text. To add page numbers and a
time stamp of when the report was created, do the following:

a. Click in the field where you want the page number to populate; then, in the formatting

menu at the top of the window, click the page number button ( ).

b. Click in the field where you want to put the date and time that the report was created,

then, in the formatting menu, click the date button ( ), and then click the time button (

).

Example of page number and report time stamp set in the footer

4. At the bottom of the window, click Submit Details.
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Run and view a report set
Use these instructions to generate and view a set of drill-down reports.

NOTE: Before you run reports from the Report Sets window, confirm that your reports have been
built, that they run correctly, and that they have been saved. Otherwise, you may receive an error
when attempting to run the set.

1. Open the Report Sets window: 
a. In themain menu header, click Reports >Drill-Down Reports.

b. On theDrill-Down Reports page, in themenu header, click Reports > Report Sets.

2. In the Report Sets tab, in the row for the desired report set, click Run.

3. In the confirmation dialog, click OK.

4. Open theDesktop Client.

5. In the Axiom Explorer, navigate to Libraries > Reports Library > CMAData > ReportSets and locate
your report.

6. Double-click the report to open and view it.

Drill through the report by clicking the plus buttons on the left, as shown in the following example.

7. After viewing the report, do any of the following:
l Close the report. When prompted to save, select to save it.
l Close the report and export it. To export the report, right-click it and select Export.
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l Close the report and delete it. To delete the report, right-click it and select Delete.

Schedule a report set to run
Use these instructions for scheduling the running of drill-down report sets. You can schedule reports to
run once or on a regular basis. To schedule reports, you need to have CMA Scheduler permissions.

NOTE: Before scheduling a report set, confirm that the reports in the set have been built, that they
run correctly, and that they have been saved.

To schedule and run a report set:
1. Open the Report Sets window: 

a. In themain menu header, click Reports >Drill-Down Reports.

b. On theDrill-Down Reports page, in themenu header, click Reports > Report Sets.

2. In the Report Sets tab, in the row for the desired report set, ensure the Enabled box is checked.

3. Open theDesktop Client.

4. In the Admin ribbon tab, click Scheduler.

5. In the Scheduler window, on the Job tab, click New.

6. Click the Add button and select Report from Query.
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7. In theNew Job tab, on the right of the Selected Report Set field, click the open folder icon to view
available reports.

8. In the Choose Report dialog, select the report to be scheduled, and then click OK.

NOTE: Only report sets that are enabled for scheduling display in the Choose Report dialog.
For details, see Create a report set.
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9. In theNew Job tab on the left, click Scheduling Rules, and then click Add. A new rule is added to
the right side of the dialog.

10. Set the run day and time:
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a. Under Day Of Week, double-click near the asterisk to activate the cell and then enter a
selection:

l * (Default): The job will be run on all days within the start / end range.

l 0-6: The job will run on the specified day(s), where 0 is Sunday and 6 is Saturday. Use
a comma or a hyphen to separatemultiple days (hyphen if the days are contiguous,
commas if not). For example, you can enter 1,3,5 for Monday, Wednesday, and
Friday, or enter 1-5 for Monday through Friday.

b. Under Hours, specify the time of day (hours) that you want the job to run, in relation to the
specified days:

l * (Default): The job will be run on all hours.

l 0-23: The job will be run on the specified hour or hours, where 0 is midnight and 23 is
11:00 PM. Use a comma or a hyphen to separatemultiple hours (hyphen if the hours
are contiguous, commas if not). For example, you can enter 0,12 to run at midnight
and noon, or enter 0-12 to run every hour from midnight to noon.

c. Under Minutes, specify the time of day (minutes) that you want the job to run, in relation
to the specified hours:

l * (Default): The job will be run on all minutes (essentially the job is run continuously,
once per minute).

l 0-59: The job will be run on the specified minute or minutes of the hour, where 0 is
the first minute of the hour and 59 is the last minute of the hour. Use a comma or a
hyphen to separatemultiple minutes (hyphen if the hours are contiguous, commas
if not). For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you enter an
hour but leave theminutes at the default asterisk, then the job will run every
minute in that hour.

11. If desired, schedule email notification to alert users when the report is available for viewing:
a. In theNew Job tab on the left, click Notification.

b. On the right, select the desired settings and specify message content.

12. Click Save and then name and save the schedule in the Contract Management or Product Line
Management folder.
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Security
Axiom Contract Management security roles
Axiom Contract Management provides four main user security roles. Following are summaries of each
role. For details, refer to the following table.

CMA Admin – User with the CMAAdmin security role have Administrative privileges within the
application.

CMA Analyst – Users with the CMAAnalyst security role have standard user level permissions within the
application.

CMA User – Users with the CMAUser security role have restricted rights.

CMA Scheduler – Users with the CMA Scheduler security role have access to the Axiom Scheduler and
ETL tools within the Axiom.

Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Contracts Add, delete,
and modify
all aspects of
the contract

View only View only No access

Simulations Add, delete,
and modify
all aspects of
a simulation

View only View only No access

9
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Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Claims
View a
Claim

l View all
tabs

l Add and
modify
Claim
Tracking

l View
Voucher

l View all tabs
l Add and modify Claim

Tracking
l ViewVoucher

View only No access

Claims Re-
calculate

All features of
re-calculate

All features of re-calculate No access No access

Claims
Track /
Assign
Claims

l Create,
delete,
and edit
user-
defined
categories

l Export
reports

l Build
filters

l Create, delete and
edit user-defined
categories

l Export reports and
claims lists

l Build filters

l View and export
Claims lists

l Run Reports using
existing filters

l Export reports

No access

Import
Data

View only.
We
recommend
contacting
support prior
to deleting
any data
from the
system.

View only View only Create,
delete,
edit Axiom
ETLS to
facilitate
loading
data into
Axiom
tables

Reports l Create,
view, edit
reports

l Build
Advanced
filters

l Create new
l View existing
l Build Advanced filters

l View/run only
l Export Reports

No access
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Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Axiom
Scheduler

No access to
Axiom jobs

No access to Axiom jobs No access to Axiom
jobs

Create,
edit,
delete,
and
schedule
Axiom
jobs
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